# Bank Account Reconciliation Guide

## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Documentation</td>
<td>2</td>
</tr>
<tr>
<td>User’s Guide Format</td>
<td>3</td>
</tr>
<tr>
<td>Using Online Help</td>
<td>4</td>
</tr>
<tr>
<td>System Basics</td>
<td>5</td>
</tr>
<tr>
<td>Parts of the Main Screen</td>
<td>6</td>
</tr>
<tr>
<td>Buttons</td>
<td>8</td>
</tr>
<tr>
<td>Menu Enhancements</td>
<td>10</td>
</tr>
<tr>
<td>Shortcut Menus and Grids</td>
<td>11</td>
</tr>
<tr>
<td>Standard Utility Screens</td>
<td>12</td>
</tr>
<tr>
<td>Security</td>
<td>14</td>
</tr>
<tr>
<td>General Ledger</td>
<td>15</td>
</tr>
<tr>
<td>Project, Grant, and Endowment Management</td>
<td>16</td>
</tr>
<tr>
<td>Exporting to Excel</td>
<td>16</td>
</tr>
<tr>
<td>Setup Wizard</td>
<td>19</td>
</tr>
<tr>
<td>General Tab</td>
<td>20</td>
</tr>
<tr>
<td>Checks Tab</td>
<td>21</td>
</tr>
<tr>
<td>Deposits Tab</td>
<td>22</td>
</tr>
<tr>
<td>Summary Tab</td>
<td>23</td>
</tr>
<tr>
<td>Wizard Finish Line</td>
<td>25</td>
</tr>
<tr>
<td>Bank Account Reconciliation</td>
<td>27</td>
</tr>
<tr>
<td>Getting Started</td>
<td>28</td>
</tr>
<tr>
<td>Reconciling Accounts</td>
<td>29</td>
</tr>
<tr>
<td>Reconciliation Adjustments</td>
<td>34</td>
</tr>
<tr>
<td>Viewing Details</td>
<td>37</td>
</tr>
<tr>
<td>Changing Settings</td>
<td>38</td>
</tr>
<tr>
<td>Adjustments</td>
<td>43</td>
</tr>
<tr>
<td>Adjustments Setup</td>
<td>44</td>
</tr>
</tbody>
</table>
Introduction

In This Chapter

Documentation .................................................................2
User’s Guide Format .........................................................3
Chapter Elements .............................................................3
Design Elements ..............................................................3
Using Online Help ...........................................................4
Welcome to Bank Account Reconciliation, an optional module, designed to enhance the \textit{Bank Accounts} module of your Blackbaud programs. With Bank Account Reconciliation, you can reconcile your bank account, track the account balance, and review in-depth details about individual transactions. The module displays all transactions affecting a single bank and lets you view information from \textit{The Raiser's Edge for Windows}.

You can add Bank Account Reconciliation to these Windows programs: Accounts Payable, Accounts Receivable, Miscellaneous Cash Receipts, Payroll, and Student Billing; and it works with General Ledger for Windows and \textit{The Raiser's Edge for Windows}.

With Bank Account Reconciliation, you can view both deposits and checks from the same screen, along with the bank account balance. For example, you can view a Student Billing deposit, Accounts Payable computer check, Miscellaneous Cash Receipts deposit, and The Raiser’s Edge batch total, all from the same screen.

\textit{Bank Account Reconciliation} does not appear as a module on the program menu. Instead, its functions appear on the menu bar of the \textit{Bank Accounts} main screen. Under the \texttt{File}, \texttt{View}, and \texttt{Utilities} menus, you can find new options that appear only with the installation of Bank Account Reconciliation.

A Setup Wizard helps you establish a beginning balance for your bank account. You can reconcile manually or electronically, and you can add adjustments, such as service fees, during reconciliation. These adjustment transactions can then be posted to your \textit{General Ledger}.

Before you begin reconciling an account, you need to perform a setup for each new and existing bank account. Bank Account Reconciliation’s Setup Wizard simplifies this process. You simply enter a beginning balance, a starting date, and then mark checks and deposits that have cleared the bank. The program determines if your account is in balance. If it is not, the program prompts you to add an adjustment or return to setup and make changes. Once you are set up for reconciliation, you can begin reconciling on a regular schedule or as determined by your organization’s needs.

As a part of the reconciliation process, you can enter adjustments, view the Bank Account register, import transactions into the register, and post adjustment activity to \textit{General Ledger}.

Bank Account Reconciliation also offers the capability of reconciling your bank account electronically using a Quicken® file provided by your bank.

\section*{Documentation}

The documentation for Bank Account Reconciliation consists of this user’s guide, an online user’s guide, and online Help.

In addition to this manual, we encourage you to use the online user’s guide. It consists of a PDF (Portable Document Format) file, which you can install on your computer during the program installation process.

You can view the online user’s guide on your computer screen. You also can print all, a few pages, or even a partial page of the manual. The online user’s guide contains links. These links let you navigate through the manual easily. With a click of your mouse, you can jump from the Table of Contents to Reports.
To view the online manual, use the Adobe Acrobat Reader®. The Acrobat Reader installs with your Blackbaud programs. If the Acrobat Reader is not installed, you can install it from your main program installation CD, or you can download it, free of charge, from the Adobe web page at http://www.adobe.com.

As part of the online Help, we have added a Notes feature. The text-ready note files are added to your Blackbaud folder during installation. Here you can enter and maintain notes about the program in the Help file as you use Bank Accounts. Your notes can contain organization-specific information about how to best use the program to suit your needs.

**User’s Guide Format**

**Chapter Elements**

Each chapter contains these elements:

- **In This Chapter:** A list of chapter contents.
- **Overview:** A brief description of the chapter.
- **Procedures:** Step-by-step instructions with explanations to complete the process.
- **Summary:** A review of chapter highlights.
- **Reference:** A detailed, field-by-field description of program screens, which appears at the end of most chapters.

**Design Elements**

The table below explains the design elements this manual uses as visual cues to denote important information.

<table>
<thead>
<tr>
<th>Format</th>
<th>Denotes</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Note" /></td>
<td>The note symbol designates a note or tip related to the information in the main text column.</td>
</tr>
<tr>
<td><img src="image" alt="Clock" /></td>
<td>The clock symbol designates a shortcut or timesaving action.</td>
</tr>
<tr>
<td><img src="image" alt="Stoplight" /></td>
<td>The stoplight symbol designates a warning or item of importance.</td>
</tr>
<tr>
<td>Bold</td>
<td>Bold text designates the name of a field or button, for example, Print.</td>
</tr>
<tr>
<td>Italics</td>
<td>Text in italics designates the name of a program module, for example, Security, or an optional module, for example, Bank Account Reconciliation.</td>
</tr>
<tr>
<td>Bold Italics</td>
<td>Text in bold italics designates a Blackbaud program name, for example, General Ledger.</td>
</tr>
<tr>
<td>small caps</td>
<td>This signifies a key on the keyboard. “Press DELETE.” refers to the key on your keyboard. “Click Delete.” refers to an on screen button.</td>
</tr>
</tbody>
</table>
CHAPTER 1

Using Online Help

When you add Bank Account Reconciliation to your Accounting for Nonprofits program, the online Help file is also added. The online Help file gives you access to overview information, reference information, and procedures.

If you need resources beyond online Help, you can access the online manual by selecting Online Documentation from the Help menu. This opens a PDF (Portable Document Format) file in Acrobat Reader. You can also access the manual from your installation CD.

We also provide files for your user-defined notes, accessed by clicking Notes on the Help file toolbar. These files (brnotes.doc and brnotes.txt) are located in your Blackbaud folder. Depending on your word processor, you can use either the Microsoft Word document or the text file. This gives you a handy place to store information specific to your organization’s needs. The big advantage of the notes file over the Annotate feature in the Help file is you can maintain one notes file for everyone in your organization. To share your notes/tips with your coworkers, copy the notes file to the Blackbaud folder on their hard drive.

If you do not have Microsoft Word, delete brnotes.doc in the \Blackbaud directory on your hard drive (or on the drive where your program resides). Once you delete brnotes.doc, the Notes button can access brnotes.txt using Notepad.

You can access online Help in two ways:

- Select Help from the menu bar, or
- Press F1 from most screens in Bank Accounts.

Selecting Help from the menu bar or pressing F1 displays a menu of Blackbaud programs installed in your system. You can select Bank Account Reconciliation from this menu to access the Contents, Index, and Find tabs in the Help file.
In This Chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parts of the Main Screen</td>
<td>6</td>
</tr>
<tr>
<td>Title Bar</td>
<td>7</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>7</td>
</tr>
<tr>
<td>Toolbar</td>
<td>8</td>
</tr>
<tr>
<td>Filters</td>
<td>8</td>
</tr>
<tr>
<td>Status Bar</td>
<td>8</td>
</tr>
<tr>
<td><strong>Buttons</strong></td>
<td>8</td>
</tr>
<tr>
<td>Toolbar Buttons</td>
<td>8</td>
</tr>
<tr>
<td>Standard Buttons</td>
<td>9</td>
</tr>
<tr>
<td><strong>Menu Enhancements</strong></td>
<td>10</td>
</tr>
<tr>
<td>File Menu</td>
<td>10</td>
</tr>
<tr>
<td>View</td>
<td>10</td>
</tr>
<tr>
<td>Utilities</td>
<td>10</td>
</tr>
<tr>
<td>Help</td>
<td>11</td>
</tr>
<tr>
<td><strong>Shortcut Menus and Grids</strong></td>
<td>11</td>
</tr>
<tr>
<td>Using Shortcut Menus</td>
<td>11</td>
</tr>
<tr>
<td>Sorting the Grid</td>
<td>12</td>
</tr>
<tr>
<td><strong>Standard Utility Screens</strong></td>
<td>12</td>
</tr>
<tr>
<td>Print Setup Screen</td>
<td>12</td>
</tr>
<tr>
<td>Calendar</td>
<td>13</td>
</tr>
<tr>
<td>Calculator</td>
<td>13</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>14</td>
</tr>
<tr>
<td>Security Options</td>
<td>14</td>
</tr>
<tr>
<td>General Ledger</td>
<td>15</td>
</tr>
<tr>
<td>Project, Grant, and Endowment Management</td>
<td>16</td>
</tr>
<tr>
<td>Exporting to Excel</td>
<td>16</td>
</tr>
</tbody>
</table>
This chapter introduces you to the enhancements found in *Bank Accounts* when you add *Bank Account Reconciliation*. You may be adding *Bank Account Reconciliation* to your existing Blackbaud programs, or you may have purchased *Bank Account Reconciliation* as part of your first Blackbaud accounting package. In either case, this chapter defines the screens you see and the *Bank Account Reconciliation* functions you now have available through *Bank Accounts*.

It is important to remember that this manual is not designed to provide all the information needed to use *Bank Accounts*. Whenever necessary, you should refer to the user’s guide for your main Blackbaud accounting program. It contains specific information about *Bank Accounts*. If you have multiple Blackbaud accounting programs, you can refer to each program’s manual since *Bank Accounts* is a shared module.

This chapter also provides basic information about navigating in the module and details about how to establish access rights to *Bank Account Reconciliation* in the Security section. It explains the differences in the module when you have Blackbaud’s *General Ledger* and *Project, Grant, and Endowment Management for Windows* installed.

Read through this chapter to gain a better understanding of the module. You can find additional detailed information and step-by-step procedures in specific chapters.

**Parts of the Main Screen**

Understanding the information in this chapter helps you navigate through the program, as well as identify *Bank Account Reconciliation* options. This information is helpful whether you are a new or longtime user of Blackbaud accounting software.

When you add *Bank Account Reconciliation* to your existing Blackbaud accounting package, additional options become available from the register in *Bank Accounts*. While the appearance changes slightly, the familiar functions remain the same.
The main screen includes a title bar, menu bar, toolbar, bank register grid, filters, and status bar. It appears when you access Bank Accounts from your main program group, such as Accounts Payable.

**Transaction Total**
changes to **Account Balance** once you complete the Setup Wizard for the account.

**Title Bar**

The title bar, located across the top of the screen, states the module name and the name of the displayed bank account register you are accessing. It also contains a Bank Accounts icon in the upper left corner. When you click this icon, a drop-down list appears, containing the screen commands: **Restore**, **Move**, **Size**, **Minimize**, **Maximize**, and **Close**. In addition, the title bar contains buttons in the upper right corner for minimizing, maximizing, and closing the screen.

**Menu Bar**

The menu bar, just below the title bar, contains the commands for all Bank Accounts functions. These basic commands, **File**, **Edit**, **View**, **Utilities**, and **Help**, contain lists of options for functions you need in Bank Accounts. With Bank Account Reconciliation, additional options appear on the basic menu, such as **Reconciliation** in the File menu and **Reconciliation History** in the View menu.

To access a command on the menu bar, either:

- Position the pointer over the desired command and click the left mouse button.

- Press **Alt** + the underlined letter. For example, to access **File**, press **Alt + F**.
CHAPTER 2

8

Toolbar

The toolbar contains buttons representing common options for Bank Accounts. It also contains options specific to Bank Account Reconciliation, such as Reconciliation.

Filters

You can control the amount of information displayed by activating any of the six filters found just below the register grid. These filters are particularly helpful when viewing many transactions from a single bank account or when searching for particular transactions. For example, you may decide you only want to see Student Billing adjustments on a certain date. You can do this by selecting Student Billing in the System filter, <All Adjustments> from Type, and entering a date range in Transaction Date. The program also lets you search by Check No. and Clear Date. Once you select your filters, be sure to click Filter Now. The program refreshes the grid with your requested information. Click New Search, and the program replaces the grid display with information from the default filters, <All>.

Status Bar

The status bar, located across the bottom of the window, acts as a guide. As you move from screen to screen, the program displays important messages on the status bar. For example, when you highlight a transaction on the Bank Accounts main screen, the status bar tells you what kind of filter you are using, the posted date, and cleared date.

Buttons

This section reviews the toolbar buttons and standard screen buttons found throughout Bank Account Reconciliation. By becoming familiar with the buttons in the program, you can accomplish tasks easier.

Toolbar Buttons

The toolbar contains buttons representing common commands in Bank Accounts and Bank Account Reconciliation. By clicking these buttons, you can easily perform a function, such as printing, without using the menu bar.

- Add a new bank account
- Add a new adjustment
- Show bank account list
- Reconcile account (send to Wizard first, if needed)

- Send to printer
- Preview data as it will print
- Establish printer settings
- Find data
These buttons appear on the Bank Account Reconciliation screen toolbar. By clicking one of these buttons, you can perform a function specific to your new optional module.

- **Begin electronic reconciliation**
- **Display all transactions in one grid**
- **Display two grids, one with checks and adjustments and another with deposits and other credits**

### Standard Buttons

As with any other Blackbaud program, there are many standard buttons that appear on the program screen rather than the toolbar. These buttons function the same regardless of location. Clicking these buttons produces the described function.

- **Search for or ‘Find’ data to fill in the field.**
- **Access the drop-down list associated with that field.**
- **Search the program to select the correct folder and file name.**
- **Calculate the appropriate financial data for the field.**
- **Locate the correct date for the field.**

- **Move back one screen or step.**
- **End an operation.**
- **Exit a screen.**
- **Return all entries to unmarked status.**
- **Search for a particular item or record in the database.**
- **Complete a procedure.**

- **Display the data in graph format.**
- **Move forward one screen to the next step.**
- **Complete an operation.**
- **Figure a new total with new numbers.**
- **Mark all entries displayed.**
- **Display a synopsis.**
Menu Enhancements

Bank Account Reconciliation adds functionality to existing menus in the Bank Accounts module. By recognizing the location of these enhancements, you can click easily from menu to menu and access all of the functions added with the installation of Bank Account Reconciliation.

File Menu

One new option – Reconciliation – appears on the File menu. Click this option to initiate the Reconciliation process. A screen with a series of tabs appears to guide you through data entry. If this is your first reconciliation for an account, clicking this button takes you directly to the Setup Wizard. Here you establish your beginning account balance, enter a beginning date, and mark transactions as cleared or not cleared.

View

The Reconciliation History option appears on the View menu only when Bank Account Reconciliation is present. Clicking this option displays a record of the ending balance, program-assigned ID, and a date for each reconciliation for a specific bank account.

Utilities

This menu enables the Post to General Ledger, Raiser’s Edge Import, and General Ledger Import utilities when Bank Account Reconciliation is present. The first utility lets you post adjustments to Blackbaud’s General Ledger or an export file of your choice. The second utility lets you import batches from The Raiser’s Edge and view RO transactions alongside AFN transactions. The third utility lets you import transactions from General Ledger into your bank register.
Help

The Help menu options remain the same. The difference occurs when you click Bank Account Help Topics. A new screen appears with program buttons, including Bank Account Reconciliation. Clicking this button displays Help Topics associated with this optional module.

Shortcut Menus and Grids

This information can help you navigate in the program more easily and find the information you need more quickly.

Using Shortcut Menus

Throughout Bank Accounts and Bank Account Reconciliation, you can access commonly used commands by placing the cursor in a field or grid and clicking the right mouse button. A shortcut menu appears, similar to the one shown below. Commands vary depending on your location in the software.
Sorting the Grid

You can sort bank register grid information in ascending or descending order, by column header item (e.g., No., Type, Date, etc.). For example, if you click the Date header with the left mouse button, the list displays in ascending order, with the oldest date at the bottom. Click the header again to change to descending order, with the oldest date at the top.

<table>
<thead>
<tr>
<th>No.</th>
<th>Type</th>
<th>Date</th>
<th>Reference</th>
<th>Checks</th>
<th>Deposits</th>
</tr>
</thead>
<tbody>
<tr>
<td>1230</td>
<td>Computer check</td>
<td>07/15/95</td>
<td>State Farm Insurance</td>
<td>$425.00</td>
<td></td>
</tr>
<tr>
<td>1359</td>
<td>Computer check</td>
<td>08/21/97</td>
<td>State Farm Insurance</td>
<td>$2,300.00</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Deposit</td>
<td>09/25/96</td>
<td>Student Billing Deposit 1</td>
<td></td>
<td>$19,084.76</td>
</tr>
<tr>
<td>2</td>
<td>Deposit</td>
<td>09/01/96</td>
<td>Student Billing Deposit 2</td>
<td></td>
<td>$50,805.14</td>
</tr>
<tr>
<td>3</td>
<td>Deposit</td>
<td>07/31/95</td>
<td>Student Billing Deposit 3</td>
<td></td>
<td>$25,399.50</td>
</tr>
<tr>
<td>4</td>
<td>Deposit</td>
<td>10/10/95</td>
<td>Student Billing Deposit 4</td>
<td></td>
<td>$7,535.00</td>
</tr>
<tr>
<td>5</td>
<td>Deposit</td>
<td>05/07/98</td>
<td>Student Billing Deposit 5</td>
<td></td>
<td>$9,300.00</td>
</tr>
<tr>
<td>1360</td>
<td>Computer check</td>
<td>09/21/97</td>
<td>The Graphic Shop</td>
<td>$705.40</td>
<td></td>
</tr>
<tr>
<td>1361</td>
<td>Computer check</td>
<td>09/21/97</td>
<td>The History Book Tours</td>
<td>$1,124.16</td>
<td></td>
</tr>
<tr>
<td>1224</td>
<td>Computer check</td>
<td>09/15/95</td>
<td>The Graphic Shop</td>
<td>$1,184.74</td>
<td></td>
</tr>
<tr>
<td>1238</td>
<td>Computer check</td>
<td>12/21/95</td>
<td>The Graphic Shop</td>
<td>$1,560.00</td>
<td></td>
</tr>
</tbody>
</table>

Standard Utility Screens

The following standard screens appear in Bank Account Reconciliation.

Print Setup Screen

You can access this screen from File, Print Setup on the menu bar. This screen lets you designate a path to your printer. It also lets you select paper orientation, size, and source.
Calendar

Fields requiring date information have a calendar button. Clicking the calendar opens the calendar as shown below. Click the left or right arrows to scroll to the desired month. Click a date to enter it in the field.

With the calendar open, you can click the name of the month to view a list of all months. You can then click on the month you want to display. If you click on the year (e.g. 1999), scrolling arrows appear, allowing you to jump to any previous or successive year.

Calculator

Fields requiring monetary values have a calculator button. Click the calculator to open the calculator.

Click the number keys to indicate the amount to be entered in the field, and then click Paste to make the entry.
Security

All Blackbaud accounting programs share a Security module. Because Bank Account Reconciliation is an optional module, you define users and groups in the Security module of your main Blackbaud accounting program. Additional security rights for Bank Account Reconciliation users become available during installation.

Bank Account Reconciliation automatically recognizes the password you use in your main Blackbaud accounting program. You do not have to redefine your password.

If you install Bank Account Reconciliation as a new Blackbaud user, Security contains a user named Supervisor whose password is admin. This user has full access rights to all areas of the software and cannot be deleted. You should change the Supervisor’s password to a unique password as soon as possible to ensure the highest level of security for your organization.

From Security, you can create an unlimited number of user groups with various levels of access. An individual’s access rights depend on the rights of the group to which the member belongs.

When opening a program or module, the program disables functions to which the individual does not have access rights. Changes can be made to a person’s access rights at any time, but the new rights do not take effect until the next time that person logs in.

You can assign individuals to more than one group. Those individuals with multiple group membership enjoy the access rights of all the groups to which they belong.

Security Options

When you open Security from your main Blackbaud program, you find Bank Account Reconciliation options added to the Bank Accounts Shared Components tab. This is where you define access rights to your new reconciliation features.

Editing a group

1. Open Security, and highlight the group you want to edit.
2. Select File, Open, and the group record opens.

The User Name can contain numbers, letters, and the underscore character.
4. Highlight **Bank Accounts** in the **Group Privileges** frame, and click **Options**. The Security Options screen appears.

5. From here, you can mark options to allow the group to have access to various functions related to the **Bank Register**, including **Run Bank Account Reconciliation**.

6. Continue to define security for the group by highlighting the different items listed in the **Functions** box.

7. Click **OK** to save your new group security definitions.

**General Ledger**

Some fields in **Bank Account Reconciliation** can be used differently, depending on whether you have Blackbaud’s **General Ledger** installed. This difference is particularly important when adding an adjustment.

When Blackbaud’s **General Ledger** is present, you can define an adjustment type and assign it debit and credit accounts that the program defaults to each time you use this adjustment type. When Blackbaud’s **General Ledger** is not present, these account number fields become text fields where you can enter information that is important to your organization.

If you would like more information about Blackbaud’s **General Ledger**, please contact Blackbaud’s Sales Department at 1-800-443-9441 or visit Blackbaud’s web site at www.blackbaud.com.
CHAPTER 2

Project, Grant, and Endowment Management

If you add the optional module called Project, Grant, and Endowment Management to Blackbaud's General Ledger, then an additional grid appears at the bottom of your New Adjustment screen.

This screen appears in Bank Account Reconciliation when you reconcile and decide to add an adjustment. It also appears in the Setup Wizard when you establish your first account balance and decide to add an adjustment.

You can easily enter details by clicking Copy Projects from and selecting Projects. Or you can manually enter information directly into the grid.

Project, Grant, and Endowment Management lets you track all transactions by project or limit your tracking only to income statement accounts.

If you would like more information about Blackbaud’s Project, Grant, and Endowment Management, please contact Blackbaud’s Sales Department at 1-800-443-9441 or Blackbaud’s web site at www.blackbaud.com.

Exporting to Excel

Using the Export to Excel function, you can export information from Bank Accounts grids into the Microsoft Excel® spreadsheet program. You cannot, however, import this information back into Bank Accounts.
With your cursor in the grid, select **File, Export to Excel**, or click the right mouse button and select **Export to Excel** from the shortcut menu.

When the export is complete, the Excel spreadsheet appears with information from the grid. Now you can manipulate this information in Excel.

If you perform another **Export to Excel** without closing the spreadsheet, the program adds a second sheet to the active workbook with the new information. This is helpful when working with multiple accounts or when preparing multi-purpose reports for board members.
Setup Wizard

In This Chapter

- General Tab ................................................................. 20
- Checks Tab ....................................................................... 21
- Deposits Tab .................................................................... 22
- Summary Tab ................................................................. 23
- Wizard Finish Line ......................................................... 25
This program makes getting started easy with the help of a Setup Wizard. Here you establish your beginning account balance, enter a beginning date, and mark transactions as cleared or not cleared. This setup process serves as your first reconciliation. You only have to run the Setup Wizard once for each new and existing account.

When you finish adding a new account in Bank Accounts, the module offers to take you to the Bank Account Reconciliation Setup Wizard. This lets you complete the setup process immediately, so your account is ready for all program procedures. If you are not ready to prepare your account for future reconciliations, you can close the message. Later you can open the Setup Wizard by selecting File, Reconciliation from the Bank Accounts main screen.

The Setup Wizard lets you enter new adjustments, if necessary, to bring your account into balance during the initial setup procedure. When Blackbaud’s General Ledger is present, you can define an adjustment type and assign it debit and credit accounts. The program defaults to these accounts each time you enter an adjustment using this adjustment type. When Blackbaud’s General Ledger is not present, these account number fields become text fields where you can enter information important to your organization. An additional Projects grid appears at the bottom of the New Adjustment screen when Blackbaud’s Project, Grant, and Endowment Management is present.

Before running the Setup Wizard, the program displays a Transaction Total in the top right corner of the Bank Accounts main screen. This is the sum of all transactions listed. Once you complete the Setup Wizard, that total becomes your Account Balance. The module records your Setup Wizard information as your first reconciliation. You can recall this information and information about all reconciliations from the Bank Accounts main screen by selecting View, Reconciliation History.

The Setup Wizard screen contains four numbered tabs: General, Checks, Deposits, and Summary. From the Setup Wizard screen, you can access five buttons: Back, Next, Cancel, Summary Report, and Finished. These buttons appear on every tab. They help you navigate in the Setup Wizard.

The main headings in this chapter are organized by tabs. You can find detailed information about each tab under a main heading with the same name. This organization can guide you through the Setup Wizard successfully.

General Tab

You can initiate the Bank Account Reconciliation Setup Wizard by selecting File, Reconciliation from the Bank Accounts menu bar. This opens the first in a series of four tabs on the Setup Wizard screen.

From the General tab, you establish the starting balance of a specific account as of a determined date. The General tab displays account information, such as Bank Name, Account ID, Account No., Account Type, Address, and Phone No.
Establishing account information

1. From the Bank Accounts main screen, select File, Reconciliation. The Bank Reconciliation Setup Wizard screen appears and displays the General tab.

   - **Step 1: Enter Starting Balance**
     - **As of** date: Enter the date you want your account balance to begin or select the calendar and click the desired date.
     - **Amount Field**: Enter your account balance, or click the calculator to figure your balance, and then enter the amount by clicking Paste.
     - Click Next to proceed to the Checks tab.

Checks Tab

From the Checks tab, you can view all checks and adjustment debits that have a transaction date on or before the As of date entered on the General tab.

- **Clearing outstanding checks**
  1. From the Setup Wizard, select the Checks tab.
If you want to mark all checks as Cleared, click Select All to save time.

2. In the Cleared column, mark any checkbox to designate individual checks as cleared, or click Select All to mark all checks.

3. If you are looking for only a few select checks, you can click Find to locate them quickly, instead of scrolling through a long list of checks. See Finding a check/deposit for details.

4. Click Next to proceed to the Deposits tab.

Finding a check/deposit

The Setup Wizard contains a Find feature to help you locate specific checks and deposits, which you can then mark as cleared or not cleared. The Find feature helps you navigate when you have many transactions saved within the module and displayed in the grid. If no checks and/or deposits display in the grid, then this feature is not available.

1. From the Checks or Deposits tab, click Find. The Find screen appears.

2. Using the drop-down list in Field, select a field on which the program can search.

3. Enter information in the Find what field.

4. For example, if you are searching for a check and entered Check No. in the Find field, then you can enter a specific check number here. The Find First and Find Next buttons become accessible.

5. Select a Match, choosing from Any part of field, Whole field, or Start of field.

6. Mark Match Case if you want to narrow your search further by having the Find feature search only for words with the same capitalization.

7. Click Find First. The program searches for and highlights the first record matching your criteria.

8. Click Find Next if you want the program to search for another record with the same attributes.

Deposits Tab

From the Deposits tab, you can view all outstanding or cleared deposits and adjustment credits in the program with a transaction date on or before the As of date.
Clearing outstanding deposits

1. From the Setup Wizard, select the Deposits tab.

   ![Bank Reconciliation Setup Wizard](image)

   - **Step 3: Mark Cleared Deposits**
     - All marked deposits have cleared the bank and are reflected in your starting balance.

   - **Deposits Tab**
     - **Bank Name**, **Check summary**, and **Deposit summary**

2. In the Cleared column, mark any checkbox to designate individual deposits that have cleared, or click **Select All** to unmark all deposits.

3. If you are looking for only a few select deposits, you can use the **Find** button to locate them quickly, instead of scrolling through a long list of deposits. See the previous procedure for details.

4. Click **Next** to proceed to the Summary tab.

Summary Tab

From the Summary tab, you can view information about your account and the transactions you included in the reconciliation. Account details display under three headings: **Bank Name**, **Check summary**, and **Deposit summary**. This is a display tab. It allows you to verify the accuracy of information before proceeding.

If you wish to mark all deposits as Cleared, click **Select All** to save time.
Previewing/printing account summary information

1. From the Setup Wizard, select the Summary tab.


3. You can export or print the report, using the toolbar buttons. When you finish, return to the Setup Wizard Summary tab by clicking the Windows close button in the upper right corner.

4. Once you have verified the data, click Finished. The program takes you to the Wizard Finish Line if your account is in balance. Proceed to step number seven.
5. If your account is out of balance, a warning screen appears.

![Out of Balance Screen]

6. You can return to the Setup Wizard to make sure you correctly marked all transactions. If you have outstanding checks and deposits or previously purged data, you can enter an adjustment to bring the account in balance.

7. To enter an adjustment, mark the second option, and click **OK**. The New Adjustment screen appears.

![New Adjustment Screen]

8. The **Projects** grid displays when Blackbaud’s *Project, Grant, and Endowment Management* is present. Type information into the grid, or click **Copy Projects from**, and select a project distribution. The module automatically enters the information and associates it with this adjustment type.

9. From the New Adjustment screen, enter **Type**, **Debit account**, and **Credit account**. You can click the down arrow and the binoculars to help you find exactly what you need.

10. Click **Save and Close**.

**Wizard Finish Line**

After viewing and printing account information from the Summary tab, you are ready to move to the Reconciliation Setup Complete screen. This is the last screen in the Setup Wizard.
Exiting the Setup Wizard

1. From the Summary tab, click Finished. The Wizard Finish Line appears if your account is in balance.

2. This screen displays another account summary, which gives you the opportunity to preview and/or print reconciliation information by clicking Summary Report.

3. When you are ready to exit Setup Wizard, click OK. The program returns you to the Bank Accounts main screen.
Bank Account Reconciliation

In This Chapter

- Getting Started ......................................................28
- Reconciling Accounts ..............................................29
- Reconciliation Adjustments ......................................34
- Viewing Details ......................................................37
- Changing Settings ..................................................38
Now that you have established access rights in Security and prepared your accounts through the Setup Wizard, you are ready to proceed to the heart of the program – reconciliation. With Bank Account Reconciliation present, you no longer need to print multiple reports and manually compare them to your bank statement to reconcile your account. Bank Account Reconciliation pulls information from each of your Blackbaud accounting programs to reconcile your account. It automatically includes deposits entered into Miscellaneous Cash Receipts, Student Billing, and Accounts Receivable; and it subtracts checks written from Accounts Payable and Payroll. You also can include batches from The Raiser’s Edge as adjustments in reconciliations. Import explanations appear in the Utilities chapter.

If you manually enter deposits or withdrawals through Journal Entry in General Ledger, you can use the adjustment transaction in Bank Account Reconciliation to reflect these entries in your check register for reconciliation. The adjustment feature also can record any interest earned or service charges imposed on a bank account.

Bank Account Reconciliation computes a balance for you once you enter a beginning balance, date, and any adjustments. The procedures in this chapter assist you in successfully completing reconciliation. In addition, you can find details here explaining how to view in-depth information about account reconciliation history and how to change your reconciliation settings.

**Getting Started**

In previous chapters, we discussed Bank Account Reconciliation as an optional module that adds functionality to Bank Accounts. For this reason, you initiate Bank Account Reconciliation procedures from the main Bank Accounts screen.

1. From your main Blackbaud accounting program, select Bank Accounts. The module opens.

   You can open Bank Accounts from Accounts Payable, Accounts Receivable, Miscellaneous Cash Receipts, Payroll, or Student Billing.

2. Select the account you want to reconcile from the drop-down list on the Bank Accounts main screen.

   ![Bank Accounts - AP+SB - Baybank National Bank](image)

<table>
<thead>
<tr>
<th>No.</th>
<th>Type</th>
<th>Date</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1283</td>
<td>Computer check</td>
<td>11/15/95</td>
<td>State Farm Insurance</td>
</tr>
<tr>
<td>1308</td>
<td>Computer check</td>
<td>12/15/95</td>
<td>State Farm Insurance</td>
</tr>
<tr>
<td>1332</td>
<td>Computer check</td>
<td>01/15/96</td>
<td>State Farm Insurance</td>
</tr>
</tbody>
</table>

The Reconciliation icon indicates the account has been successfully prepared for reconciliation. If this icon does not appear, you need to run the Setup Wizard for this bank account.
3. Select **File, Reconciliation.** The Reconcile Bank Account screen appears.

![Reconcile Bank Account Screen](image)

From Reconcile Bank Account, you can:

- Reconcile a bank account.
- Save an incomplete reconciliation.
- Correct an out-of-balance reconciliation.
- View reconciliation history.
- View reconciliation detail.

### Reconciling Accounts

You can complete the reconciliation process from as few as three screens. This section discusses filtering transactions, clearing debits and credits and reconciling bank accounts. If you need to enter adjustments during reconciliation, be sure to read the next section called Reconciliation Adjustments.

#### Completing the Reconcile Bank Account screen

1. From the Reconcile Bank Account screen, enter the date you want to appear in the **Reconciliation date** field.

2. In the **Ending balance** field, enter a designated amount.

If setup has not been completed for the selected bank account, the module automatically takes you to the Setup Wizard when you click the calculator. Please see the Setup Wizard chapter for more information.

We recommend using the date and balance from a bank statement to save computation time and ensure accuracy.
3. Enter any necessary adjustments by typing an amount for existing adjustment types. If you do not need to enter adjustments, then type zero in the **Amount** column for listed adjustments, or highlight the adjustment and click **Delete**.

   The adjustments on this screen default from the last reconciliation run. If you need to create new adjustments, see the procedure called **Adding a new adjustment during reconciliation**.

4. Once you enter a **Reconciliation date**, **Ending balance**, and adjustment **Amounts**, click **Begin Reconciliation**.

   This takes you to the Bank Account Reconciliation screen where you can filter transactions, clear transactions, and reconcile your account.
Filtering transactions during reconciliation

This procedure lets you control the data displaying on screen. It is particularly helpful when you have a lot of data to view or when your bank statement is organized with credits in one column and debits in the other.

1. From the Bank Account Reconciliation screen, click the drop-down arrows in the **System**, **Type**, and **Status** fields.

These three filters let you define which transactions appear in the register. For example, you may choose to view only cleared transactions in **Accounts Payable** rather than all systems, types, and statuses as shown. This can help you organize a large account.
2. Select \textit{View, Separated Transactions} to see an alternate view of the same information.

\begin{itemize}
  \item This lets you view checks and adjustments in one column and deposits and other credits in another column by simply switching the view.
\end{itemize}

\textbf{Clearing debits and credits from an account}

Once you complete this procedure, the \textit{Difference} field should display zero. If it does not display zero, please see the \textit{Correcting an out-of-balance reconciliation} procedure in this chapter.

1. From the Bank Account Reconciliation screen, mark the checkbox for each cleared transaction.

   You can click \textbf{Select All} or \textbf{De-select All} to mark or unmark all transactions at the same time.

2. If \textit{Difference} does not display zero, change the cleared status of one or more transactions, or enter an adjustment to bring the account in balance before reconciling.

   Please see the procedure \textit{Adding an adjustment during reconciliation} to accomplish the latter.

   The program clears the marked transactions and removes them from the grid during the reconciliation process.

\textbf{Generating a Pre-Reconciliation Report}

1. From the Bank Account Reconciliation screen, click \textbf{Pre-Reconciliation Report}. The report displays.

2. Using the toolbar buttons, you can print, e-mail, or export the report.

3. When you finish viewing the report, close the screen. The module returns to the Bank Account Reconciliation screen.
Reconciling a bank account

For this procedure to work, **Difference** on the Bank Account Reconciliation screen must display zero. If it does not display zero, please see the procedure called **Correcting an out-of-balance reconciliation**.

1. From the Bank Account Reconciliation screen, click **Reconcile Now** to complete your reconciliation.

   The module clears the marked transactions from the grid to reconcile your account, and the Reconciliation Complete screen appears.

2. Click **OK** to return to the **Bank Accounts** main screen.

   This completes the bank account reconciliation process.

Correcting an out-of-balance reconciliation

1. From the Bank Account Reconciliation screen, click **Reconcile Now** when **Difference** displays a value other than zero. The Out of Balance screen appears.

2. Click **OK** to activate the default setting, **Return to bank reconciliation**. This takes you to the Bank Account Reconciliation screen.

3. Review your transactions and mark as cleared any you may have missed.

4. Click **Reconcile Now**.

5. If **Difference** still displays a value other than zero, then the Out of Balance screen appears again.
6. If you do not want to review your transactions again, then mark **Enter an adjustment now to bring the reconciliation into balance.** The New Adjustment screen appears.

The program automatically enters the amount required to bring the account into balance.

7. Enter **Type**, **Reference**, **Debit account**, and **Credit account**.

8. Click **Save and Close**. The Reconciliation Complete screen appears.

➢ **Saving an incomplete reconciliation**

This procedure is useful when you need to exit a reconciliation before it is complete. The module lets you leave without losing your work.

1. From the Bank Account Reconciliation screen, click **Reconcile Later**.

2. The program automatically saves your work and returns to the **Bank Accounts** main screen. Since this process is automatic, you do not have to name your reconciliation or select a file path. The module does this work for you.

➢ **Opening an incomplete reconciliation**

1. From the **Bank Accounts** main screen, select **File, Reconciliation**.

2. The program automatically opens your last incomplete reconciliation from the bank account currently selected.

### Reconciliation Adjustments

This section explains how to access, add, edit, and delete adjustment and adjustment types during reconciliation. Adjustment types refer to the category of adjustments that use general ledger debit and credit accounts. An adjustment is the specific use of an adjustment type.
Accessing an existing adjustment type during reconciliation

1. From the Reconcile Bank Account screen or the Bank Account Reconciliation screen, click **New Adjustment**. The New Adjustment screen appears.

2. For **Type**, select an existing adjustment type.

   The program automatically fills the debit and credit account fields with information entered on the **Bank Information**, Adjustments tab.

3. Enter an **Amount**. You can click the calculator to figure and then enter an amount.

4. Enter a **Reference** to distinguish this adjustment from previous adjustments of this same type.

5. Click **Save and Close**. The program enters your adjustment on the Reconcile Bank Account screen.

Adding a new adjustment during reconciliation

This procedure works from the first reconciliation screen called Reconcile Bank Account or from the second reconciliation screen called Bank Account Reconciliation. This gives you maximum flexibility in the program to enter your adjustments as needed.

1. Click **New Adjustment** from the Reconcile Bank Account or Bank Account Reconciliation screen. The New Adjustment screen appears.

2. Select an existing adjustment **Type** from the drop-down list.

3. Enter information in all required fields: **Date**, **Amount**, **Reference**, **Post status**, **Post date**, **Debit account**, and **Credit account**.

4. Click **Save and Close**. The program returns to the previous screen and records your new adjustment.
Adding a new adjustment type during reconciliation

1. From the Reconcile Bank Account screen, click New Adjustment. The New Adjustment screen appears.
2. Enter the new adjustment Type you want to use during this reconciliation.
3. Tab to the next field, and a message screen appears.
4. Click Yes if you want the program to remember the information you enter in the debit and credit account fields. This becomes the default information, which the program saves under File, Bank Information, Adjustment Types tab.

   This new adjustment type becomes an option in the Type field drop-down menu. The next time you use this type, the program automatically fills the debit and credit account fields with the default information.

   or

   Click No if you want the program to record the Account Type only on the Bank Information, Adjustment Types tab. It still would appear as an option in the Type field drop-down menu on the New Adjustment screen, but without any default debit and credit account information.
5. Enter information in all required fields: Date, Amount, Reference, Post status, Post date, Debit account, and Credit account.
6. Click Save and Close. The program returns to the Reconcile Bank Account screen and records your new adjustment.

Editing an adjustment during reconciliation

1. From the Reconcile Bank Account screen, highlight the adjustment you want to edit.
2. Click Open. An adjustment screen appears with the information displaying as it was entered on the New Adjustment screen.
3. Enter your changes in any of the available fields.
4. Click Save and Close. The program enters your changes to the adjustment on the Reconcile Bank Account screen.

Deleting an adjustment during reconciliation

1. From the Reconcile Bank Account screen, click in the Amount column for the adjustment you want to delete.
2. Enter zero. This retains the adjustment type but eliminates the adjustment from the current reconciliation.
Deleting an adjustment type during reconciliation

1. From the Reconcile Bank Account screen, highlight the adjustment you want to delete.
2. Click **Delete**. The program deletes the adjustment from the Reconcile Bank Account screen. It also deletes the general ledger default debit and credit information from the **File, Bank Information, Adjustment Types** tab while retaining the name of the adjustment type. This allows you to restore this adjustment type, if necessary.

Viewing Details

This program lets you recall information about past reconciliations. By following the steps in these procedures, you can recall all reconciliations from a single account or a single reconciliation within an account.

Viewing reconciliation history

If you want to view a list of all reconciliations from one account, follow the steps below.

1. On the **Bank Accounts** main screen, open the account you wish to view.
2. Select **View, Reconciliation History**. A new screen appears listing each reconciliation ending balance, ID, and date.

<table>
<thead>
<tr>
<th>Reconciliation Date</th>
<th>Reconciliation Ending Balance</th>
<th>Reconciliation ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>04/30/99</td>
<td>$50,000.00</td>
<td>1</td>
</tr>
<tr>
<td>04/30/99</td>
<td>$96,352.00</td>
<td>4</td>
</tr>
<tr>
<td>05/13/99</td>
<td>$52,700.00</td>
<td>2</td>
</tr>
<tr>
<td>05/14/99</td>
<td>$56,000.00</td>
<td>3</td>
</tr>
<tr>
<td>06/15/99</td>
<td>$22,356.11</td>
<td>7</td>
</tr>
<tr>
<td>06/30/99</td>
<td>$37,218.64</td>
<td>8</td>
</tr>
<tr>
<td>07/15/99</td>
<td>$46,823.19</td>
<td>9</td>
</tr>
</tbody>
</table>

3. Click **OK** to return to the Bank Accounts main screen.

Viewing reconciliation detail

If you wish to view information about a specific reconciliation, follow the steps below.

1. From the Reconciliation History screen, highlight the reconciliation you wish to view.
2. Click **Show Detail**. The Reconciliation Detail screen appears.

![Reconciliation Detail screen](image)

3. Click **OK** to return to the Reconciliation History screen.

4. Click **OK** a second time to return to the *Bank Accounts* main screen.

### Changing Settings

The procedures in this section let you adapt settings to your personal preference. By following these procedures, you can change preferences, passwords, toolbar displays, legend settings and column order.

#### Changing reconciliation preferences

1. From the Bank Account Reconciliation screen, select **Edit, Preferences**. The Reconciliation Preferences screen appears, displaying the General tab.

![Preferences screen](image)

From the General tab, you can change the presence and color of grid lines on the Bank Account Reconciliation screen.
2. Mark **Show horizontal lines** and/or **Show vertical lines** to remove the check and the grid lines on the Bank Account Reconciliation screen. The module defaults to marked check boxes.

3. Click **Background color**, choosing either even lines or odd lines, and a palette with color squares appears.

![Color selection palette]

4. Click a color box.

5. Click **OK**. The module returns you to the Reconciliation Preferences screen.

6. Select the Check Position tab.

7. Enter or select a printer in the **Select the printer to adjust** field.

8. Click **OK** to return to the Bank Account Reconciliation screen and view your selected preferences.

9. Select the General Ledger tab.

10. In the **Bank Account Source** field enter a source for your bank account.

11. In the **Journal Entry** frame, enter the journal references that you want.

12. Click **OK**, to return to the preferences screen.

#### Changing your password

1. From the Bank Account Reconciliation screen, select **Edit, Change Password**. A new screen appears.

![Change Password dialog box]

2. Type your **Old password**, **New password**, and **Confirm new password**. Your password can contain up to eight characters.
3. Click OK. The module returns you to the Bank Account Reconciliation screen.

> Removing Toolbar and/or Summary display

You can increase the size of the grid on the Bank Account Reconciliation screen by removing the toolbar and/or summary display from the screen.

1. From the Bank Account Reconciliation screen, select View, Toolbar and/or Summary.

2. The screen refreshes and a larger grid appears.

This example shows the Bank Account Reconciliation screen with the toolbar and summary display removed. This provides room to view more transactions simultaneously.
Changing the legend settings

1. From the Bank Account Reconciliation screen, select View, Legend. The Bank Account Reconciliation Legend screen appears.

   ![Bank Account Reconciliation Legend Screen]

   The module uses the color black as the default setting for Bank Account Reconciliation screen transactions. The exception is cleared transactions, which default to blue.

2. Click a box to open a palette of color squares. You can change the color setting for: Computer checks, Electronic funds transfers, Bank drafts, Adjustments, Manual checks, Direct disbursements, and Regular deposits.

3. Mark the checkbox to select a color for Use Color for Posted Transactions and/or Use Color for Cleared Transactions.

4. Click on the corresponding checkbox to open the color palette and make your selection.

5. When you are finished, click OK to return to the Bank Account Reconciliation Legend screen.

6. Click OK to return to the Bank Account Reconciliation screen.
Changing the column order

1. From the Bank Account Reconciliation screen, click View, Columns. The Define Column Order screen appears.

2. By clicking Up and Down, you can re-arrange the order of the grid columns to suit your needs.

3. Click Reset to System Defaults to return to the program settings.

4. Click Cancel to reverse any changes you made and return to the Bank Account Reconciliation screen.

5. Click OK to implement the changes and return to the Bank Account Reconciliation screen.
Adjustments

In This Chapter

Adjustments Setup .................................................. 44
New Adjustments ..................................................... 46
Adding an adjustment in Bank Account Reconciliation is easy thanks to the module’s ability to remember and reuse adjustment types. The first step in adding an adjustment is setting up an adjustment type. This process associates your adjustment type with debit and credit accounts in your general ledger. Then when you want to add an adjustment, you can select an adjustment type and amount, and Bank Account Reconciliation automatically enters the corresponding account information to create your adjustment. This reduces typing time, ensures accuracy, and speeds reconciliation.

You can plan ahead and establish adjustment types by selecting File, Bank Information, and the Adjustment Types tab from the Bank Accounts main screen. Or you can add adjustment types as needed, even during reconciliation, from the New Adjustment screen. You can create as many adjustment types for as many bank accounts as needed.

Bank Account Reconciliation lets you edit or delete any unreconciled adjustments. The module automatically enters these adjustments into Blackbaud’s General Ledger (if present) the next time you post. The program posts the adjusted amounts to specified fiscal years and periods based on the adjustment post dates.

If you do not have Blackbaud’s General Ledger, the account number fields become text fields. You can enter information specific to your accounting system.

**Adjustments Setup**

If you have frequently used categories of adjustments, you can define them as adjustment types from the Bank Information function. These procedures let you establish general ledger debit and credit accounts for your common adjustment types. Then each time you create an adjustment using a defined adjustment type, the program automatically enters the correct account information.

**Accessing the Adjustment Types tab**

1. From the drop-down list of accounts on the Bank Accounts main screen, select the account to which you want to add an adjustment type.
2. Select File, Bank Information. The Bank Account opens.
3. Select the Adjustment Types tab. The tab appears.

You can add unlimited Adjustment Types and associate them with your general ledger accounts.

**Adding an adjustment type**

This procedure shows you how to customize adjustment types to your organization’s needs. If you added adjustment types while in the Setup Wizard or during a reconciliation, the Adjustment Types tab remembers the new type you added but not the default accounts. You need to define this information here.

1. From the Adjustment Types tab, enter an **Adjustment Type** specific to your organization.
2. Adjustment types can include anything from ATM fees to bounced check fees, minimum balance fees, monthly service charges, and more.
3. Type the **Default Debit Acct**, or click the binoculars to look up and select the account number.
4. This designates the **General Ledger** account the program will enter as debit account each time you use this adjustment type.
5. The program automatically pulls the **Description** of the account from Blackbaud’s **General Ledger**.
6. Type the **Default Credit Acct**, or click the binoculars to look up your internal audit expense account number.
7. This designates the **General Ledger** account the program will enter as credit account each time you use this adjustment type.
8. The program automatically pulls the **Description** of the account from Blackbaud’s **General Ledger**.
9. Click **OK**. The module returns to the **Bank Accounts** main screen.
Editing an adjustment type

This procedure is useful when you need to change an account number or add a new expense category to include expenses currently saved within an existing adjustment type.

1. From the Bank Information screen, Adjustment Types tab, locate the adjustment type you want to edit.
2. Enter your changes.
3. Click OK. The program saves your changes and returns to the Bank Accounts main screen.

Deleting an adjustment type

1. From the Bank Information screen, Adjustment Types tab, highlight the adjustment type you want to delete.
2. Press the Delete key. A warning message appears.
3. Click Yes to delete.
4. If you have an outstanding adjustment with this type, a warning message appears.
5. The program will not let you delete the adjustment type until you post the outstanding adjustment with this assigned type.
6. Click OK. This program saves the changes you made and returns to the Bank Accounts main screen.

New Adjustments

Once you define adjustment types for your bank account, you are ready to begin making adjustments. You do this from the New Adjustment screen. If you find you need to add more adjustment types, the program lets you do this at any time.

Opening the New Adjustment screen

1. From the Bank Accounts main screen, use the drop-down list of accounts to select and display the account in which you want to add an adjustment.

The **Projects** grid appears only when the optional module *Project, Grant, and Endowment Management* is installed.

- **Adding an adjustment**
  1. From the New Adjustment screen, select the adjustment **Type** from the drop-down list or enter a new one.
  2. If you enter a new type, a message screen appears asking if you want to add it to the list. Click **OK**.
  3. Enter the **Date** of the adjustment or click the calendar to select a date.
  4. Enter in the adjustment **Amount** or click the calculator to figure and enter the amount.
  5. The module automatically enters a **Reference** based on what you entered in **Type**. You can type in new information if you want to change what the module entered.
  6. Enter an adjustment **Note**. This is optional.
  7. Select a **Post status** from the drop-down list, choosing from **Do Not Post** or **Not Yet Posted**.
  8. Type a **Post date** or click the calendar to locate and select a date.
  9. Type a **Debit account** number. If you have Blackbaud’s *General Ledger*, click the binoculars to locate and select an account number.
  10. If your debit and credit accounts cross funds, then enter information in **Interfund**.
  11. If you have the optional module *Project, Grant, and Endowment Management*, then you can click **Copy Projects From** to enter information in the **Projects** grid. You also can enter information directly into the grid. This lets you track all transactions by project distribution.
12. Click **Save and Close** or use the drop-down arrow to select **Save** or **Save and New**.
Utilities

In This Chapter

Posting to General Ledger ...........................................50
Posting Rules ..............................................................50
Posting Procedures .......................................................51
Raiser’s Edge Batches .....................................................54
General Ledger Import ....................................................56
This chapter describes the functions available from the Utilities menu of Bank Accounts when Bank Account Reconciliation is present. Here you perform general database tasks. You can post transactions to Blackbaud’s General Ledger and import batches from The Raiser’s Edge.

You perform these tasks by selecting Utilities on the Bank Accounts main screen. A drop-down list appears with the choices Post to General Ledger, Purge Voided Checks, Raiser’s Edge Import, and General Ledger Import.

If you need information about Purge Voided Checks, you can find this in your main Blackbaud accounting program manual.

**Posting to General Ledger**

When posting adjustments from Bank Account Reconciliation, you can post directly to Blackbaud’s General Ledger for Windows (if present) or to an export file of your choice. The posting process includes all adjustments from all banks with the Not Yet Posted status and updates the status to Posted.

This portion of the chapter explains the rules associated with posting to General Ledger. After a review of the rules, you find procedures to complete the three tabs on the general ledger posting screen. In the program, this screen is called the Post Adjustments for All Banks to General Ledger screen.

**Posting Rules**

All adjustments with a status of Not Yet Posted are processed and posted to the appropriate fiscal year and period as determined by the post date. For example, if you add and post an adjustment in June with a post date of 12/31/99, then the adjustment activity appears in the December 1999 fiscal period of your ledger.

The posting process creates transactions according to the following guidelines.

Post Charges/Credits from Bank Account Reconciliation to Blackbaud’s General Ledger:

Post a $100 charge added with a post date of 08/01/96:

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>08/01/96</td>
<td>Revenue</td>
<td></td>
<td>100.00</td>
</tr>
<tr>
<td>08/01/96</td>
<td>AR Summary</td>
<td>100.00</td>
<td></td>
</tr>
<tr>
<td>Totals:</td>
<td></td>
<td>100.00</td>
<td>100.00</td>
</tr>
</tbody>
</table>

Post a $100 credit added with a post date of 09/01/96:

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>09/01/96</td>
<td>Revenue</td>
<td>100.00</td>
<td></td>
</tr>
<tr>
<td>08/01/96</td>
<td>AR Summary</td>
<td></td>
<td>100.00</td>
</tr>
<tr>
<td>Totals:</td>
<td></td>
<td>100.00</td>
<td>100.00</td>
</tr>
</tbody>
</table>
Posting Procedures

The first three procedures in this section explain all of the tabs and fields involved in posting to General Ledger. In addition, this section tells you how to print/preview a pre-posting report.

- Completing the General tab

  1. From the Bank Accounts main screen, click Utilities, Post to General Ledger. A new screen appears, displaying the General tab.

2. Using the drop-down list, select a Post Bank Account Adjustments with source code. You can select from source codes defined by your organization in the Configuration module of Blackbaud’s General Ledger.

3. Select Post directly to Blackbaud’s General Ledger or Create an export file in this format.

   If you choose the export option, select a file format and enter the filename and location where you want to save the file.

4. Click Next. This takes you to the Posting Details tab.
Completing the Posting Details tab

From this tab, you determine how you want each transaction type to post. A grid with four tabs lets you mark Post Method, Reference Type, and Reference for each Transaction Type.

1. From the Post Adjustments for All Banks to General Ledger screen, select the Posting Details tab. The screen refreshes and displays the selected tab.

2. For each transaction type listed, use the drop-down list to select a Post Method. Choose from Detail or Summary.

3. For each transaction type listed, use the drop-down list, to select a Reference Type. Choose from Custom or <Default>.

4. For each transaction type with a custom Reference Type, enter up to 50 characters of Reference information.

5. If you choose <Default> as your Reference Type, the program automatically enters the <Transaction Date> in the Reference field.

6. Select to Summarize transactions by Fiscal Period or Post Date.

7. Click Next. This takes you to the Format tab.
Completing the Format tab

1. Select the Format tab from the Post Adjustments for All Banks to General Ledger screen. The screen refreshes and displays the selected tab.

2. Select a setting in the Sort Report By column by clicking in a field within the column. A down arrow button appears. When you click the button, a drop-down list appears. Select from Account number, Date, Project ID, Reference, Source code, Transaction number, and Transaction date.

3. Select a setting in the Order column by clicking in a field within the column. A down arrow button appears. When you click the button, a drop-down list appears. Select from Ascending or Descending.

4. Mark Print control report on if you want the module to print a report when you click Post Now.

5. Click Post Now to send adjustments for posting to Blackbaud’s General Ledger and return to the Bank Accounts main screen.

Printing/previewing a pre-posting report

1. From the Post to General Ledger utility, enter the required information on the General, Posting Details, and Format tabs.

2. Click Pre-Post Report to display the report.

3. Click the printer to send the displayed report to the printer.

4. When you finish printing/previewing the report, click the Windows exit box in the upper right corner. This returns you to the Post to General Ledger utility.

5. Click Cancel to return to the Bank Accounts main screen without posting; or click Post Now to post to Blackbaud’s General Ledger and then return to the Bank Accounts main screen.
Raiser’s Edge Batches

Bank Account Reconciliation lets you import and view batch information from The Raiser’s Edge. Before you can import this information, you first must do two preliminary tasks: confirm the batch is available for import and prepare Bank Account Reconciliation to import the batch. The following three procedures give you detailed information to import a batch for viewing from The Raiser’s Edge into Bank Account Reconciliation.

Confirming The Raiser’s Edge batch availability for import

1. Before you import your batches from Bank Account Reconciliation, you first need to open your batch in The Raiser’s Edge.
2. Check to see if the Include Batch for Bank Depositing option is marked.
3. If it is marked, then close The Raiser’s Edge. You are ready to perform the next procedure, Prepare Bank Account Reconciliation to accept batches.
4. If the option is not marked, then this batch is not available for import.
5. If you have questions about this, be sure and refer to your user’s guide for The Raiser’s Edge.

Preparing Bank Account Reconciliation to import batches

1. From the Bank Accounts main screen, display the account in which you want to import batches by selecting it from the drop-down list of accounts.
2. From the menu bar, select File, Bank Information.
3. Click the Blackbaud Systems tab.
4. In the Blackbaud systems box, mark Raiser’s Edge. A new frame with new options appears.
5. From the drop-down list, you can select **Raiser’s Edge database is a local database** or **network database**.

6. When you select **local database**, a field with a **Browse** button appears. Click the ellipsis to locate your database for *The Raiser’s Edge*.

7. When you select network database, enter **Raiser’s Edge server name**, **Raiser’s Edge database name**, and **Network protocol**.

8. From **Raiser’s Edge adjustment type** is, select an adjustment type to associate with batches from *The Raiser’s Edge*. If you first need to establish a new adjustment type for this, click the Adjustment Types tab and create a new adjustment type.

9. Click **OK**. The module takes you back to the **Bank Accounts** main screen.

**Importing a batch**

1. From the **Bank Accounts** main screen, select **Utilities, Raiser’s Edge Import**. A new screen appears.

2. Enter **Adjustment type** and **Include batches with a post date of**. The program selects all batches with this type and post date. Once you import this information into **Bank Account Reconciliation**, you can then generate reconciliation reports about *The Raiser’s Edge*. You can refer to the Adjustments chapter for more details about how **Adding an adjustment type**.

Any batches you plan to import must first be posted from *The Raiser’s Edge* to General Ledger.
3. Click Next. The Raiser’s Edge Batches tab appears.

4. In the Import column, mark the checkboxes of the batches you want to import.

5. Click Print Batch Report to ensure you are importing exactly what you need.

6. Click Import Batches Now.

**General Ledger Import**

The latest release of this product contains an exciting new feature. From the Utilities menu, you can now select General Ledger Import and add transactions to your Bank Accounts module that were manually posted to General Ledger. You can import any transactions entered in Journal Entry, such as a bank service charge. The bank service charge would post as an adjustment from Bank Accounts.

An Import Wizard makes the transfer of information easy from one Blackbaud program to another. The wizard searches the selected General Ledger cash accounts and creates adjustments for all transactions that meet your criteria. By completing the information on four wizard tabs, you can import needed information into your Bank Accounts module.
Completing the General tab

1. From the Bank Accounts main screen, select Utilities, General Ledger Import. A wizard screen appears.

2. Enter a name for the Adjustment type to create. Choose from a drop-down list of your established adjustment types.

3. You can enter a new type in this field. A confirmation message appears asking if you want to add this type to the list. Click Yes to add it to the list.

4. From Set adjustment date as, use the drop-down menu to select Batch post date, Batch created on date, or Batch date last changed.

5. Enter a Start date and End date.

6. From Import, select Debits and Credits, Debits Only, or Credits only.

7. Click Next. The Source Codes tab appears.
Completing the Source Codes tab

This tab lets you choose to import only those transactions with designated source codes. Or, you can choose to import transactions with all source codes.

1. From the General Ledger Import Wizard, select the Source Codes tab.

2. Mark Include all source codes or Include only selected source codes.

3. If you marked the latter option, then click the arrow buttons to move selected source codes into the Include only these source codes box.

4. Click Next. The Cash Accounts tab appears.

Completing the Cash Accounts tab

1. From the General Ledger Import Wizard, select the Cash Accounts tab.

2. From the Include column, mark the accounts you want to search for transactions to add to the bank register.

3. Click Next. The General Ledger Transactions tab appears.
Completing the General Ledger Transactions tab

1. From the General Ledger Import Wizard, select the General Ledger Transactions tab.

2. From the Import column, mark the transactions you want added to the bank register.

3. Click Preview Transaction Report. The report displays listing all batches that qualify for import.

4. Click Import Adjustments Now.

The program gives all imported transactions a post status of Posted and locks this status to prevent duplicate posting.
All Blackbaud accounting programs include a shared Reports module. Since Bank Account Reconciliation is an optional module, you can access Reports from any Blackbaud accounting program.

When you receive Bank Account Reconciliation, you also receive an update to your main Blackbaud accounting program. This update includes added functionality for Reports to work with Bank Account Reconciliation. Be sure to install this update before attempting to generate Bank Account Reconciliation reports.

The reports for each module are broken down by category and by type within each category. From the Reports main screen, you can create a total of six different types of reports from three categories for Bank Account Reconciliation. The categories appear below in bold, followed by available report types.

**Analysis Reports**  
- Bank Summary Reports  
- Reconciliation Reports  
- System Analysis Reports

**Transaction Reports**  
- Register Reports  
- Transaction Reports

**Reconciliation Reports**  
- Batch Reconciliation

Each type of report has a set of parameter tabs. You select options from the General, Blackbaud Systems, Transaction Type, and Format tabs to produce custom reports. All of the report types utilize the same four tabs except the Reconciliation Reports, which only uses the General and Format tabs, and the Batch Reconciliation Reports, which uses the General, Format, Transaction Criteria, and Accounts tabs.

Once you create a set of parameters from the tabs, you can name and save the new settings to produce a specific report. You can preview, print, export, and e-mail all of your reports.

The procedures in this chapter show you how to access the Reports module, change preferences, and generate reports. You can apply the lessons learned from this chapter to create any of the five types of reports associated with Bank Account Reconciliation.

Be sure to refer to the Reference section for specific information about any additional fields or options that do not appear in the procedures.

## Getting Started

> **Opening the Reports main screen**

The main screen lets you perform a variety of functions common to all reports, as well as define certain automatic features for all reports you create.

1. From the Start menu, select Programs and your main Blackbaud accounting program. A submenu of the program’s modules appears.
2. Select **Reports**. The *Reports* module opens, displaying the main screen.

3. Here you see a list of Blackbaud program folders, which contain lists of all available reports.

4. Double click the **Bank Account Reconciliation** folder to view its three report categories: **Analysis Reports**, **Reconciliation Reports**, and **Transaction Reports**.

5. Click the plus sign beside each category to view a list of all available report types.

6. Under the **Analysis Reports** folder, you find the template to create a **Bank Summary Report**, **Reconciliation Report**, or **System Analysis Report**. Under the **Reconciliation Reports** folder, you find the template to create a **Batch Reconciliation Report**. Under the **Transaction Reports** folder, you find the template to create a **Register Report** or **Transaction Report**.
Before you begin to create reports, you can establish some overall preferences for use in all reports you define.

1. From the Reports main screen, select Edit, Preferences. The Preferences screen appears.

2. Mark Automatically save report parameters if you want to eliminate the need to select File, Save after creating a report.

3. Mark Show only my reports if you do not want to see any of the reports other users create.

4. Define Double click preference by selecting Open, Export, Mail, Preview, or Print. This determines what happens when you double click a saved report listed on the main screen.

5. In the Font Options frame, select the font type and size you want to use in your reports. You can choose from the drop-down lists of styles and font sizes, and then choose to apply your choices to either the Entire Report or just the Detail Section of your reports.

6. Select Paper Orientation. You can choose to have the orientation determined by the report type or individually select an orientation from the Print Setup screen each time you print.

7. Click OK to save preferences and return to the main screen.

Creating Reports

The procedures in this section explain all of the tabs and fields involved in creating a Bank Summary Report. These procedures also apply to creating the other five types of reports. You may encounter a few variations in available fields. When this happens, please refer to the Reference section for an in-depth explanation.
Completing the General tab

1. From the Reports main screen, double click Bank Reconciliation Reports.
2. Double click the Analysis Reports folder to reveal three types of reports.

4. Click the Bank account down arrow, and select the account for which you want to create a report.
5. In the Transaction date of field, click the down arrow to select the date of transactions to include on the report.
6. Choose from 20 entries. If you select <Specific range>, you can enter a date range. This field does not let you add entries.
7. Mark the options you want included on the report from the Include Transactions with these Statuses frame. You can choose Outstanding, Cleared on, Reconciled on or Voided on. If you select <Specific range>, you can type in a date range.
8. Mark Not Yet Posted, Posted, and/or Do Not Post to determine which transactions with these post statuses to include.
9. Select a Post date of to correspond with the post status you selected.
10. After completing the frames on the General tab, you are ready to proceed to the Blackbaud Systems tab.

The Reports Reference Manual provides information about all Blackbaud reports. Please call the Blackbaud Sales Department for information about how to receive this manual.
Completing the Blackbaud Systems tab

1. Click the Blackbaud Systems tab, or click the Back and Next buttons to display this tab.

2. Mark Include all Blackbaud systems or Include only selected Blackbaud systems.

3. If you mark the latter option, then you can use the right and left arrow buttons to move your selections.

4. After completing the Blackbaud Systems tab, you are ready to proceed to the Transaction Type tab.
Completing the Transaction Type tab

1. Click the Transaction Type tab, or click the **Back** and **Next** buttons to display this tab.

2. Mark **Include all transaction types** or **Include only selected transaction types**.

3. If you mark the latter option, then you can use the right and left arrow buttons to move your selections.
Completing the Headings options on the Format tab

1. Click the Format tab, or click the Back and Next buttons to display this tab. The tab displays with the Headings option marked.

2. From the Heading Format frame, you can enter a Title and Subtitle for your report. The program default uses the report type as the Title, but you can change this.

3. Click the down arrow in the Align field, and select Left, Center, or Right.

4. Mark Print organization name in header if you want the program to include this name on the report automatically.

5. Mark the Print Page No. in Heading frame if you want this included on your report.

6. Click the Format down arrow, and choose from Page 1, p1, or 1, depending on how you want your report to appear.

7. Click the Align down arrow, and choose from Left, Center, or Right, depending on how you want your report to appear.

8. Mark the Print Report Date in Heading frame if you want this included on your report.

9. Click the Format down arrow, and select from Short Date, Long Date, Short Date and Time, or Long Date and Time.

10. Click the Align down arrow, and choose from Left, Center, or Right.

11. Mark Print report heading on each page if you want the program to do this automatically.
Completing the Criteria options on the Format tab

1. From the Format tab, mark Criteria. The tab refreshes and displays a new frame.

2. Mark Print Report Criteria if you want the program to print this information automatically when it prints a report.

3. Select the criteria you want to see printed at the end of the report.

4. Choose from: Saved report name, Bank account, Transaction date range, Transaction status, Cleared date range, Reconciled date range, Voided date range, Post status, Post date range, Blackbaud systems to include, and Transaction types to include.

5. Mark the option to see this criteria printed On a separate page or On the first page.
Completing the Page footer options on the Format tab

1. From the Format tab, mark **Page footer**. The tab refreshes and displays new frames.

![Page footer options on the Format tab]

2. In the **Text** box, you can type a reference note to appear as a page footer on your report.

3. Use the down arrow in the **Align** field to determine whether this footer appears **Left**, **Center**, or **Right** justified at the bottom of the report.

4. Mark **Print Page No. in Footer** if you want this included on your report.

5. Click the **Format** down arrow, and choose from **Page 1**, **p1**, or **1**, depending on how you want your report to appear.

6. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**, depending on how you want your report to appear.

7. Mark **Print Report Date in Footer** if you want this included on your report.

8. Click the **Format** down arrow, and select from **Short Date**, **Long Date**, **Short Date and Time**, or **Long Date and Time**.

9. Click the **Align** down arrow, and choose from **Left**, **Center**, or **Right**.
Completing the Report footer options on the Format tab

1. From the Format tab, mark **Report footer**. The tab refreshes and displays a new frame.

2. In the **Text** box, you can type a reference note to appear as a report footer on your report.

3. Use the down arrow in the **Align** field to determine whether this footer appears **Left**, **Center**, or **Right** justified at the end of the report.
Completing the Miscellaneous options on the Format tab

1. From the Format tab, mark Miscellaneous. The tab refreshes and displays new frames.

2. Select a Report Orientation. Choose from Portrait or Landscape. The Bank Summary Report only uses the Portrait format.

3. Select a Report Format. Choose from Detail or Summary.

4. From the Amount Display Options frame, select how you want monetary figures to display on your report.

5. You can choose to Show currency character, Show 1000’s separator, Show decimals, Show percent sign, or Show blanks instead of zero amounts.

6. Click the down arrow in the Negative amount format field, and decide whether you want negative numbers to display with the negative sign or in parenthesis.
Completing the Transaction Criteria tab

This tab appears only when setting Batch Reconciliation Report parameters.

1. From the New Batch Reconciliation Report screen, select the Transaction Criteria tab.

2. Mark the transactions you want to include in the report.

3. For the Post date, select a date.
Completing the Accounts tab

This tab appears only when setting Batch Reconciliation Report parameters.

1. From the New Batch Reconciliation Report screen, select the Accounts tab.

2. Mark All Accounts, Selected accounts, or Range of accounts.

3. From the Account No. column, click the binoculars and select an account. A default Description automatically appears.

Saving a report

1. After you complete the parameter tabs in Reports, select File, Save. A new screen appears.

2. The program automatically enters a report name, which you can change.

3. Type a report Description. This field is not required.

4. If you want to allow others to generate or modify this report, mark the corresponding checkboxes.

5. Click OK. The program returns to the New Report screen.
Previewing/printing a report

We recommend previewing a report before printing to ensure the information and formatting are correct.

1. From Reports, display the parameter tabs screen for the report you want to preview/print.
2. Click Preview from the bottom right corner of the screen. The program processes your data and displays the report.
3. From the sample report screen, you can print, refresh, export, and e-mail the report by clicking the corresponding toolbar buttons.
4. When you finish previewing, click the print button on the toolbar if you are satisfied with the report.
   or
5. Close the sample report, and the program takes you back to the Reports main screen where you can reopen and modify the report. You can click Print from the parameters screen if you do not wish to see another preview report.

Modifying a report

1. From Reports, display the parameter tabs screen for the report you want to modify.
2. From the parameter tabs screen, click Next or Back to find the frame you want to modify.
3. Enter any changes you want to make to the report.
4. Click Layout to view a sample report layout. The program processes sample data and displays a report using your parameters. This shows you the report appearance to help you modify your parameters accordingly.
5. Close the sample report, and the program returns to the parameter tabs screen where you can continue modifying your report parameters.

Exporting/e-mailing a report

1. From the Reports main screen, locate the saved report you want to export and highlight it.

   ![Export Screen]

3. Using the drop-down lists, select the format in which you want to export/e-mail the report, and select the destination of the export/e-mail, such as Disk file.
4. Click **OK**. The Character-Separated Values screen appears.

![Character-Separated Values](image)

5. Select values, and click **OK**. The Number and Date Format Dialog screen appears.

![Number and Date Format Dialog](image)

6. Mark the checkboxes if you want to keep the same number and date formats in the export as they are in the report.

7. Click **OK**. The program exports or e-mails the report file.
Reference

This section of the chapter provides field-by-field descriptions of the tabs used in creating Bank Account Reconciliation reports. We show and explain all of the tabs used to create these reports. Each field is assigned a type: R for required, O for optional, D for display only, and B for button.

Since four tabs are common to most of the reports, we show these tabs once, followed by any variations. You can create Bank Account Reconciliation reports from the Reports module of any main Blackbaud program. Bank Account Reconciliation options become available upon installation.

Accounts Tab

This tab appears when creating a new batch reconciliation report. From the Accounts tab, you select the accounts from which you will draw information to include in your report. You can choose to include All accounts, Selected accounts, or a Range of accounts.

<table>
<thead>
<tr>
<th>Account No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>01-111800-00-00</td>
<td>Checking Account: Bank1</td>
</tr>
<tr>
<td>01-155000-00-00</td>
<td>Intercoastal Savings and Loan cash account</td>
</tr>
<tr>
<td>01-111400-00-00</td>
<td>Petty Cash</td>
</tr>
<tr>
<td>01-155000-00-00</td>
<td>Business Office</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account No. (R)</td>
<td>When you click your cursor in this field, the binoculars appear. You can click this button to locate the account number or type the account number directly in this field.</td>
</tr>
<tr>
<td>Description (D)</td>
<td>A default description automatically appears once you enter an account number.</td>
</tr>
</tbody>
</table>
Blackbaud Systems Tab

From the Blackbaud Systems tab, you select the programs from which you will draw information to include in your report.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include all Blackbaud systems (O)</td>
<td>Mark this option if you want to generate a report containing bank activity from all of your Blackbaud programs. This is the default setting.</td>
</tr>
<tr>
<td>Include only selected Blackbaud systems (O)</td>
<td>Mark this option if you want to limit the information in your report to bank activity from specific Blackbaud programs. Highlight selected programs in the left box, and use the arrow keys to move them into the right box. The double arrow button moves everything. The single arrow button moves only highlighted programs.</td>
</tr>
</tbody>
</table>

Format tab

The Format tab appears on all reports in Reports for Bank Account Reconciliation, and it lets you define the way your report looks when you print or view it. It contains a selection of five Format Options for use in defining your report format. Choose from Headings, Criteria, Page footer, Report footer, and Miscellaneous. When selected, each option produces a new set of boxes with more options to further define your report appearance. A picture and description of each of the five options follows.
Headings Options

The Headings option lets you choose what you want to include in the heading of the report as well as each page of the report. Select this option to reveal boxes where you define a heading title, subtitle, and alignment. You can add page numbers and a date. And you can decide whether to print a heading on each page or not.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heading Format (O)</td>
<td>In the <strong>Heading Format</strong> frame, you can enter a <strong>Title</strong> for your report. This field can contain a maximum of 60 characters. The program enters the report type as the default for <strong>Title</strong>. If you decide to leave this field blank, your report prints without a title. You also can enter a subtitle if you want and define the location of the title in the header as <strong>Left</strong>, <strong>Center</strong>, or <strong>Right</strong>. If you want the name of your organization to print in the report header, mark the option to indicate this choice.</td>
</tr>
<tr>
<td>Print Page No. in Heading (O)</td>
<td>Mark this option to include page numbers in your report. This enables two drop-down lists where you can select the format and alignment of page numbers. In <strong>Format</strong>, select <strong>Page 1</strong>, <strong>p1</strong>, or <strong>1</strong>, depending on whether you want the word “Page” spelled out with the number, just “p” with the number, or only the page number. In <strong>Align</strong>, select from <strong>Left</strong>, <strong>Center</strong>, or <strong>Right</strong>, depending on where you want the page number to appear.</td>
</tr>
<tr>
<td>Print Report Date in Heading (O)</td>
<td>Mark this option to include the date in your heading. This enables two drop-down lists where you can select the date format and alignment. In <strong>Format</strong>, select <strong>Short Date</strong>, <strong>Long Date</strong>, <strong>Short Date and Time</strong>, or <strong>Long Date and Time</strong>. In <strong>Align</strong>, select from <strong>Left</strong>, <strong>Center</strong>, or <strong>Right</strong>, depending on where you want the date to appear.</td>
</tr>
<tr>
<td>Print report heading on each page (O)</td>
<td>If you want all heading information you define to appear at the top of each page, you can mark this checkbox. If left unmarked, the report heading prints at the top of the first page only. You can view a sample of the heading format you define by clicking <strong>Layout</strong>; or you can preview the entire report by clicking <strong>Preview</strong>.</td>
</tr>
</tbody>
</table>
Criteria Options

When you mark the Print Report Criteria option, the program enables a list of all appropriate criteria related to the report in the display window. Simply mark those criteria you want to print on your report. You can choose to have this criteria print On a separate page or On the first page.

Page Footer Options

The Page footer format option lets you define text as you want it to appear in the footer of each page of your report.

You can elect to have a page number and/or date print in the footer of each page. This is an option to print the information in the heading of each page, as offered in the Headings format option.
Report Footer Options

If you want to define text to be entered at the end of the report (not necessarily at the bottom of the last page), you can enter the text in the Report Footer Text frame box.

You also can choose to align this text to the Left, Center, or Right.

Miscellaneous Options

The Miscellaneous option lets you choose how you want amounts to display in your report.
From the General tab, you establish transaction filters for your report. You can use this tab to create the Bank Summary, System Analysis, Register, and Transaction Reports. The Reconciliation Report also uses a General tab, but it contains different frames, which are explained following this tab.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Orientation (R)</td>
<td>This frame lets you know what orientation options are available. In this example, Portrait is the only option. Some reports allow both Portrait and Landscape, and corresponding option buttons let you choose how you want your report to look. You also can set your Reports Preferences to allow you to choose the paper orientation at the time of printing or allow the program to use the orientation defined for the report. Typically, this option is used only with wide-carriage, dot-matrix printers.</td>
</tr>
<tr>
<td>Report Format (R)</td>
<td>This frame lets you choose to create your report in Detail or Summary format.</td>
</tr>
<tr>
<td>Amount Display Options (O)</td>
<td>This frame lets you choose whether you want a currency character, 1000s separator, decimals, and/or percent signs to show in your report. You can choose to show all negative amounts with a minus sign or the default parentheses.</td>
</tr>
<tr>
<td>Sample Display (D)</td>
<td>As you mark any of the checkboxes in Amount Display Options, the results appear in the Sample Display frame.</td>
</tr>
</tbody>
</table>

### General Tab

From the General tab, you establish transaction filters for your report. You can use this tab to create the Bank Summary, System Analysis, Register, and Transaction Reports. The Reconciliation Report also uses a General tab, but it contains different frames, which are explained following this tab.

### New Bank Summary Report

**Name (Type*)**

**Reference**

| Name account (R) | This drop-down list contains a selection of all your accounts saved in Bank Accounts. |

Press F3 for today's date, F7 for calendar.
### General Tab - Reconciliation Report

You can use this tab to create the **Reconciliation Report**. From the General tab for the **Reconciliation Report**, select a bank account. The program automatically enters a **Beginning balance** when you mark **Print last completed reconciliation**.

#### Name (Type*) | Reference
---|---
Include Transactions with these Dates (R) | Use the drop-down list in this frame to select a *Transaction date of*. If you choose **Specific range**, more fields appear where you enter your range. You can choose to enter only a **Start** or **End** date or both.

Include Transactions with these Statuses (R) | Mark the checkboxes in this frame to activate filters. Choose from **Outstanding**, **Cleared on**, **Reconciled on**, and **Voided on**. Once you have selected your filters, you can define dates in the drop-down lists beside the checkboxes. If you choose **Specific range**, more fields appear where you can enter your range.

Include Transactions with these Post Statuses (R) | Mark these checkboxes to activate filters. Choose from **Not Yet Posted**, **Posted**, and **Do Not Post**. If you select **Posted**, then enter a **Post date of**. Once again, if you select **Specific range**, more fields appear where you can enter your range.

Preview (B) | Click **Preview** to see a sample of the report, which you can then close and return to the **Reports** main screen. You can reopen the report if you are not finished creating it.

Layout (B) | Click **Layout** to view the layout of a sample report. This lets you see what the final report will look like and helps you plan your parameters accordingly.
CHAPTER 7

Transaction Type Tab

From the Transaction Type tab, you select the various types of transactions from which you will draw information to include in your report.

Sample Reports

This section of the chapter provides you with a sample report and overview description of each report available with Bank Account Reconciliation. A listing of all the tabs used to create the report appears below the report description. Details about each tab appears in the Reference section. If you have questions about a field or tab, please refer to the Reference section for detailed information.
This report is useful in determining the status of a bank account before a bank statement arrives. You can filter the report in a variety of ways to select specific information in either a detail or summary format. This is useful when providing bank information to auditors or board members.

**Tabs:** General, Blackbaud Systems, Transaction Type, Format
Reconciliation Report

Lowcountry Preservation Society
Reconciliation Report

Bank ID: AP-SB  
Bank Name: Baybank National Bank  
Account Number: 753-121-977  
Account Type: Checking

<table>
<thead>
<tr>
<th>Transaction Number</th>
<th>Transaction Date</th>
<th>Transaction Type</th>
<th>Reference</th>
<th>Clear Date</th>
<th>Transaction Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deposits 5</td>
<td>05/07/1998</td>
<td>SB-Deposit</td>
<td>Student Billing Deposit 5</td>
<td>01/01/1999</td>
<td>$9,300.00</td>
</tr>
<tr>
<td>Checks 1362</td>
<td>08/21/1997</td>
<td>AP-Computer Check</td>
<td>UPS</td>
<td>01/01/1999</td>
<td>($405.01)</td>
</tr>
<tr>
<td></td>
<td>09/16/1997</td>
<td>AP-Direct Disbursement</td>
<td>Andy Creed Foundation</td>
<td>01/01/1999</td>
<td>($5,500.00)</td>
</tr>
<tr>
<td>Adjustments 02/10/1999</td>
<td>Adjustment-adjust</td>
<td>66-908-01</td>
<td></td>
<td></td>
<td>$5,493.01</td>
</tr>
</tbody>
</table>

1 transaction(s) listed (25.00% of total) for Reconciled Deposits: $9,300.00
2 transaction(s) listed (50.00% of total) for Reconciled Checks: ($5,905.01)
1 transaction(s) listed (25.00% of total) for Reconciled Adjustments: $5,493.01

GRAND TOTAL: $8,888.00
A Total of 4 Transaction(s) listed

ENDING STATEMENT BALANCE $8,888.00

BEGINNING BALANCE $3,394.99

CURRENT ACCOUNT BALANCE $12,282.99

The Reconciliation Report provides a way of trouble-shooting issues before you receive your bank statement. From this report, you can print the last completed reconciliation or a future reconciliation. The future reconciliation format lets you keep a computer balance of the current account without actually reconciling the account. This is similar to the transaction register you use to manually balance a personal checking account until your bank account statement arrives.

Tabs: General, Format
The System Analysis Report organizes bank records by Blackbaud program, and lists summary information about selected Blackbaud programs. For example, it can provide the number of deposits entered from Student Billing or the amount of checks entered in Accounts Payable.

Tabs: General Blackbaud Systems, Transaction Type, Format
Register Report

02/12/1999

Lowcountry Preservation Society

Register Report

Bank ID: AP-SB
Bank Name: Baybank National Bank
Account Number: 753-121-977
Account Type: Checking

<table>
<thead>
<tr>
<th>Transaction Number</th>
<th>Transaction Type</th>
<th>Date</th>
<th>Reference</th>
<th>Status</th>
<th>Amount</th>
<th>Account Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1335</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Amato Business Systems</td>
<td>Outstanding</td>
<td>($625.00)</td>
<td>($625.00)</td>
</tr>
<tr>
<td>1336</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Auto Express</td>
<td>Outstanding</td>
<td>($125.30)</td>
<td>($750.30)</td>
</tr>
<tr>
<td>1337</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Baybank Visa</td>
<td>Outstanding</td>
<td>($763.01)</td>
<td>($1,513.31)</td>
</tr>
<tr>
<td>1338</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>BellSouth</td>
<td>Outstanding</td>
<td>($1,347.27)</td>
<td>($2,860.58)</td>
</tr>
<tr>
<td>1339</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Blanche Darby Florist</td>
<td>Outstanding</td>
<td>($87.37)</td>
<td>($2,947.95)</td>
</tr>
<tr>
<td>1340</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Bug-Be-Gone</td>
<td>Outstanding</td>
<td>($453.00)</td>
<td>($3,400.95)</td>
</tr>
<tr>
<td>1341</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Business Weekly</td>
<td>Outstanding</td>
<td>($25.00)</td>
<td>($3,425.95)</td>
</tr>
<tr>
<td>1342</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Carpet Master</td>
<td>Outstanding</td>
<td>($193.95)</td>
<td>($3,619.90)</td>
</tr>
<tr>
<td>1343</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>CPW - Water Company</td>
<td>Outstanding</td>
<td>($473.53)</td>
<td>($4,093.43)</td>
</tr>
<tr>
<td>1344</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>DL Landscaping and Design</td>
<td>Outstanding</td>
<td>($1,500.00)</td>
<td>($5,593.43)</td>
</tr>
<tr>
<td>1345</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Federal Express</td>
<td>Outstanding</td>
<td>($896.58)</td>
<td>($6,490.01)</td>
</tr>
<tr>
<td>1346</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>FirstPage Cellular</td>
<td>Outstanding</td>
<td>($124.75)</td>
<td>($6,614.76)</td>
</tr>
<tr>
<td>1347</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>General Hardware</td>
<td>Outstanding</td>
<td>($140.33)</td>
<td>($6,755.09)</td>
</tr>
<tr>
<td>1348</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Greene, Powers and Smith</td>
<td>Outstanding</td>
<td>($450.00)</td>
<td>($7,205.09)</td>
</tr>
<tr>
<td>1349</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Hard Drive Computers</td>
<td>Outstanding</td>
<td>($750.00)</td>
<td>($7,955.09)</td>
</tr>
<tr>
<td>1350</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>High and Dry Storage</td>
<td>Outstanding</td>
<td>($627.10)</td>
<td>($8,582.19)</td>
</tr>
<tr>
<td>1351</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Kinder Law Firm</td>
<td>Outstanding</td>
<td>($480.24)</td>
<td>($9,062.43)</td>
</tr>
<tr>
<td>1352</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Live Oak Inn</td>
<td>Outstanding</td>
<td>($288.41)</td>
<td>($9,350.84)</td>
</tr>
<tr>
<td>1353</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Lotta Latte</td>
<td>Outstanding</td>
<td>($900.00)</td>
<td>($10,250.84)</td>
</tr>
<tr>
<td>1354</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Party Rent-All</td>
<td>Outstanding</td>
<td>($316.48)</td>
<td>($10,567.32)</td>
</tr>
<tr>
<td>1355</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Positively Postal</td>
<td>Outstanding</td>
<td>($213.60)</td>
<td>($10,780.92)</td>
</tr>
<tr>
<td>1356</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Russell Janitorial Service</td>
<td>Outstanding</td>
<td>($1,350.00)</td>
<td>($12,130.92)</td>
</tr>
<tr>
<td>1357</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Sam's Club</td>
<td>Outstanding</td>
<td>($203.25)</td>
<td>($12,334.17)</td>
</tr>
<tr>
<td>1358</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>Southern Utilities</td>
<td>Outstanding</td>
<td>($1,890.72)</td>
<td>($14,224.89)</td>
</tr>
<tr>
<td>1359</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>State Farm Insurance</td>
<td>Outstanding</td>
<td>($2,300.00)</td>
<td>($16,524.89)</td>
</tr>
<tr>
<td>1360</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>The Grafix Shop</td>
<td>Outstanding</td>
<td>($705.40)</td>
<td>($17,230.29)</td>
</tr>
<tr>
<td>1361</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>The History Book Tours</td>
<td>Outstanding</td>
<td>($142.16)</td>
<td>($17,372.45)</td>
</tr>
<tr>
<td>1362</td>
<td>AP-Computer Check</td>
<td>08/21/1997</td>
<td>UPS</td>
<td>Outstanding</td>
<td>($405.01)</td>
<td>($17,777.46)</td>
</tr>
</tbody>
</table>

A total of 28 transaction(s) listed

GRAND TOTAL: ($17,777.46) ($17,777.46)

ACCOUNT STATISTICS

<table>
<thead>
<tr>
<th>(Charge) (Credit)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Checks</td>
</tr>
<tr>
<td>Total Activity</td>
</tr>
<tr>
<td>Total Voided Item</td>
</tr>
</tbody>
</table>

The Register Report provides information about bank account records. It lets you filter data and display specific information. For example, this report can provide a current bank account status appropriate for managers or provide a summary statement appropriate for board members.

Tabs: General, Blackbaud Systems, Transaction Type, Format
### Transaction Report

**Lowcountry Preservation Society**

**Transaction Report**

**02/12/1999**

<table>
<thead>
<tr>
<th>Transaction Number</th>
<th>Transaction Date</th>
<th>Transaction Type</th>
<th>Reference</th>
<th>Status</th>
<th>Status Date</th>
<th>Transaction Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1335</td>
<td>08/21/1997</td>
<td>AP-Computer ChekAmato Business Systems</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($625.00)</td>
<td></td>
</tr>
<tr>
<td>1336</td>
<td>08/21/1997</td>
<td>AP-Computer ChekAuto Express</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($125.30)</td>
<td></td>
</tr>
<tr>
<td>1337</td>
<td>08/21/1997</td>
<td>AP-Computer ChekBaybank Visa</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($763.01)</td>
<td></td>
</tr>
<tr>
<td>1338</td>
<td>08/21/1997</td>
<td>AP-Computer ChekBellSouth</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($1,347.27)</td>
<td></td>
</tr>
<tr>
<td>1339</td>
<td>08/21/1997</td>
<td>AP-Computer ChekBlanche Darby Florist</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($87.37)</td>
<td></td>
</tr>
<tr>
<td>1340</td>
<td>08/21/1997</td>
<td>AP-Computer ChekBug-Be-Gone</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($453.00)</td>
<td></td>
</tr>
<tr>
<td>1341</td>
<td>08/21/1997</td>
<td>AP-Computer ChekBisiness Weekly</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($25.00)</td>
<td></td>
</tr>
<tr>
<td>1342</td>
<td>08/21/1997</td>
<td>AP-Computer ChekCarpet Master</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($193.95)</td>
<td></td>
</tr>
<tr>
<td>1343</td>
<td>08/21/1997</td>
<td>AP-Computer ChekCPW - Water Company</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($473.53)</td>
<td></td>
</tr>
<tr>
<td>1344</td>
<td>08/21/1997</td>
<td>AP-Computer ChekDL Landscaping and Design</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($1,500.00)</td>
<td></td>
</tr>
<tr>
<td>1345</td>
<td>08/21/1997</td>
<td>AP-Computer ChekFederal Express</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($896.58)</td>
<td></td>
</tr>
<tr>
<td>1346</td>
<td>08/21/1997</td>
<td>AP-Computer ChekFirstPage Cellular</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($124.75)</td>
<td></td>
</tr>
<tr>
<td>1347</td>
<td>08/21/1997</td>
<td>AP-Computer ChekGeneral Hardware</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($140.33)</td>
<td></td>
</tr>
<tr>
<td>1348</td>
<td>08/21/1997</td>
<td>AP-Computer ChekGreene, Powers and Smith</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($450.00)</td>
<td></td>
</tr>
<tr>
<td>1349</td>
<td>08/21/1997</td>
<td>AP-Computer ChekHard Drive Computers</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($750.00)</td>
<td></td>
</tr>
<tr>
<td>1350</td>
<td>08/21/1997</td>
<td>AP-Computer ChekHigh and Dry Storage</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($627.10)</td>
<td></td>
</tr>
<tr>
<td>1351</td>
<td>08/21/1997</td>
<td>AP-Computer ChekKinder Law Firm</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($480.24)</td>
<td></td>
</tr>
<tr>
<td>1352</td>
<td>08/21/1997</td>
<td>AP-Computer ChekLive Oak Inn</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($288.41)</td>
<td></td>
</tr>
<tr>
<td>1353</td>
<td>08/21/1997</td>
<td>AP-Computer ChekLotta Latte</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($900.00)</td>
<td></td>
</tr>
<tr>
<td>1354</td>
<td>08/21/1997</td>
<td>AP-Computer ChekParty Rent-All</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($316.48)</td>
<td></td>
</tr>
<tr>
<td>1355</td>
<td>08/21/1997</td>
<td>AP-Computer ChekPositively Posta</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($213.60)</td>
<td></td>
</tr>
<tr>
<td>1356</td>
<td>08/21/1997</td>
<td>AP-Computer ChekRussel Janitorial Service</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($1,350.00)</td>
<td></td>
</tr>
<tr>
<td>1357</td>
<td>08/21/1997</td>
<td>AP-Computer ChekSam's Club</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($203.25)</td>
<td></td>
</tr>
<tr>
<td>1358</td>
<td>08/21/1997</td>
<td>AP-Computer ChekSouthern Utilities</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($1,890.72)</td>
<td></td>
</tr>
<tr>
<td>1359</td>
<td>08/21/1997</td>
<td>AP-Computer ChekState Farm Insurance</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($2,300.00)</td>
<td></td>
</tr>
<tr>
<td>1360</td>
<td>08/21/1997</td>
<td>AP-Computer ChekThe Grafix Shop</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($705.40)</td>
<td></td>
</tr>
<tr>
<td>1361</td>
<td>08/21/1997</td>
<td>AP-Computer ChekThe History Book Tours</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($142.16)</td>
<td></td>
</tr>
<tr>
<td>1362</td>
<td>08/21/1997</td>
<td>AP-Computer ChekJPS</td>
<td>Outstanding</td>
<td>08/21/1997</td>
<td>($405.01)</td>
<td></td>
</tr>
</tbody>
</table>

**A total of 28 transaction(s) listed**

**GRAND TOTAL:**

($17,777.46)

The **Transaction Report** provides information about specific bank account transactions. You can use this report to reconcile a bank account with your general ledger. You can manipulate this report to display only posted transactions. This helps you pinpoint transactions that would affect your general ledger. You also can have the report generate valuable information to assist you during audits.

**Tabs:** General, Blackbaud Systems, Transaction Type, Format
Electronic Funds Transfer

In This Chapter

Electronic Funds Transfer .................................................. 92
Setting EFT Parameters ...................................................... 92
Creating a Prenote Authorization File ................................. 93
Summary ................................................................. 94
Electronic Funds Transfer refers to the general banking system by which transactions, such as deposits and bill payments, are made through computer databases and electronic files.

As the name implies, this process takes place electronically. It requires little or no physical paperwork, and the process is almost instantaneous, compared to the days or weeks of traditional payment processing. Money does not physically change hands. It is transferred electronically from the payer’s account into the payee’s account.

Blackbaud’s *Electronic Funds Transfer (EFT)* optional module adds electronic transfer capabilities throughout existing modules of Blackbaud programs. *EFT* allows you to set up your bank account information to process electronic fund transfers. You can also set up automatic direct debit payments for payers. The direct debit process generates a transaction file that is sent to a clearinghouse organization for the actual electronic transfer of funds.

*EFT* adds fields and options to *Configuration, Security, Bank Accounts, Students, Reports, Query and Export, Cash Receipts, and Utilities and Housekeeping.*

**Electronic Funds Transfer**

Before you establish or generate automatic payments, create the EFT file, and query or export any *EFT* information, you need security access. Visit *Security* in the Blackbaud program with which you will use *EFT* and *Bank Account Reconciliation*. There you establish access rights as explained in the Security chapter of your main Blackbaud program.

**Setting EFT Parameters**

In *Bank Accounts*, you set up the *EFT* parameters for any program with EFT transactions. This identifies your organization and your bank for any electronic transfer files you create.

- **Setting EFT parameters for your bank account**
  1. From the drop-down menu on the *Bank Accounts* main screen, select the account for which you want to create an EFT file.
3. Click **Electronic Funds Transfer**. A new screen appears.

4. Enter the **Default output file path** or click **Browse** to select the path where you will create electronic file transfers.

5. Select File format options.
   These are not required and do not affect the electronic transfer files you create; however, your financial institution may have specific file format guidelines for you to follow. If appropriate, enter a **Header record reference** and mark the checkboxes to indicate whether or not to **Create debit transaction** (automatically adds a debit transaction in the EFT file) and **Include carriage return/line feed** (inserts CR/LF to indicate the end of a line in the electronic transfer file).

6. Select an **Immediate Origin** option.
   If you don’t use **Transit/Routing no.**, you must mark **Other** and enter the alternate identifier.

7. If appropriate, enter the **Entry description**.
   This is an optional two-character code included in the electronic transfer file.

8. Enter logon card information obtained from your bank.
   You can enter up to five logon cards for this bank by clicking **Insert** and then filling in the **Control string**; the system automatically completes the **Logon card no.** Add more logon cards by clicking **Insert** again.

9. Click **OK** to save the EFT parameter information and return to the Blackbaud Systems tab.

### Creating a Prenote Authorization File

Before you begin electronic funds transfer, the receiving bank often requires a prenote authorization file. This is a test record. You send it to the bank to ensure correct transmission of coding, amounts, account numbers, etc.
Creating a prenote authorization file

1. From the Bank Accounts Register, click the drop-down menu and select a bank account.


3. Click the ellipsis to search for and select a vendor.

4. Enter the name of the file to be created.

5. Select any EFT parameters to be changed and click Modify EFT Parameters.

6. Click Create Prenote File Now.

Summary

This appendix showed you how to set up your bank account to process electronic funds transfers. After completing the procedure in this chapter, you now can complete paperless transactions.
Electronic Reconciliation

In This Chapter

Electronic Reconciliation .......................................................... 96
Sample QIF Formats ................................................................. 98
Electronic Reconciliation lets you compare your bank’s Quicken Interchange Format (.QIF) with your Blackbaud file. Matches occur when the transaction type, date, amount, and reference from both the .QIF and Blackbaud formats are the same. The program marks all matching transactions with a cleared status. Once matches are found, you can then run the reconciliation process to reconcile the account. Electronic Reconciliation works only if your bank uses the .QIF format.

Electronic Reconciliation

You must run each account through the Setup Wizard before attempting to reconcile. Review the Setup Wizard chapter to complete this. Once you have run the wizard, you are ready to reconcile.

- Running electronic reconciliation


   ![Reconcile Bank Account PY - Nations Bank](image)

   - Beginning balance: $45,593.57
   - Last reconciled on: 04/02/2001
   - Last reconciled by: Supervisor

2. Enter a Reconciliation date and Ending balance.
3. Click **Begin Reconciliation**. A new screen appears.


5. Enter the **File name**. You can type the name directly into the field or click the ellipsis to locate and enter the information.

6. Click **OK**. The module reconciles your account electronically and displays an **Electronic Reconciliation Report**.

7. Close the report, and the module returns to the Bank Reconciliation screen.
Sample QIF Formats

<table>
<thead>
<tr>
<th>Sample .QIF Formats</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>!Type:Bank D7/27/95 T0.00 CX POpening Balance L[Wachovia Checking]</td>
<td>First record = Header record. D7/27/95 = Date of opening balance is 7/27/95. T0.00 = Opening balance for the period is $0.00.</td>
</tr>
<tr>
<td>D7/27/95 T15,000.00 CX NDEP PCharleston Inc. LInvestment Income ^</td>
<td>D7/27/95 = Deposit date is 7/27/95. T15,000.00 = Amount of the deposit is $15,000.00. CX = Cleared. NDEP - This is a deposit transaction because there is text after the “N” and the amount on the T line is positive. PCharleston Inc. = “Charleston Inc.” is the deposit description on an AFN deposit. LInvestment Income = “Investment Income” is a comment and is ignored for our purposes.</td>
</tr>
<tr>
<td>D7/30/95 T-236.52 CX N1200 PPositively Postal LJob Expense ^</td>
<td>D7/30/95 = Payment date is 7/30/95. T-236.52 = Amount of the payment is $-236.52. CX = Cleared. N1200 = This is a payment transaction because there is text after the “N” and the amount on the T line is negative. PPositively Postal = “Positively Postal” is the payee field on an AFN check, EFT, etc... LJob Expense = “Job Expense” is a comment and is ignored for our purposes.</td>
</tr>
<tr>
<td>D7/30/95 T-50.00 CX N PSam’s Club LHousehold ^</td>
<td>D7/30/95 = Adjustment date is 7/30/95. T-50.00 = Amount of the adjustment is $50.00. CX = Cleared. N = This is an adjustment transaction because the value after the “N” is blank (the “N” line may be missing for adjustments also). PSam’s Club = “Sam’s Club” is the reference field on an AFN adjustment. LHousehold = “Household” is a comment and is ignored for our purposes.</td>
</tr>
</tbody>
</table>

Electronic Reconciliation Processing Legend

<table>
<thead>
<tr>
<th>Compare</th>
<th>QIF File</th>
<th>AFN 7 Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Date</td>
<td>D Line</td>
<td>Date of payment, deposit, or adjustment.</td>
</tr>
<tr>
<td>Transaction Amount</td>
<td>T Line</td>
<td>Amount of payment, deposit, or adjustment.</td>
</tr>
<tr>
<td>Transaction Type</td>
<td>N Line (N + text and a positive transaction amount = deposit, N + text and a negative transaction amount = payment, N + blank or no N line = adjustment.)</td>
<td>Transaction type (payment, deposit, or adjustment).</td>
</tr>
</tbody>
</table>
Glossary

Symbols

* (asterisk) – a wildcard operator used in Global Change. Using * as a wildcard tells the program that * can stand for any string of characters. For example, when searching for someone whose last name is Johnson, but you are not sure how to spell it, you want to search for Jo*son or Jo*s?n (if you are not sure of the ending). This would return results like Jonson, Jonsen, Johnson, Johsen, etc.

< > – information contained between the greater than and less than sign is used as an example. The exception occurs when you define criteria as punctuation written out between the signs, then the greater than / less than signs represent the punctuation mark. For example, <hyphen> means the hyphen symbol is included.

% (percent) – found in Query and Export, the percent sign can replace a series of characters. For example, if you query to find a note written by someone with a last name beginning with “John,” you can use the criteria “Author Like John%.” The program selects notes with Author beginning with “John” (e.g., Johnson, Johnston, Johns, and Johnathan-Willis).

? (question mark) – a wildcard operator used in Global Change. Using ? as a wildcard tells the program that ? can stand for one character. For example, if you are searching for someone whose last name is Johnson, but you are not sure if it is spelled with an o or an e at the end, you want to search for Johns?. This would return results like Johnson, Johnsen, Johnsan, etc.

Accounts – a Blackbaud module found in General Ledger where you add, edit, and delete account records as well as enter budget information, organize and maintain your Chart of Accounts, and copy a range of accounts from one fund to another.

Accounts Payable – Blackbaud’s comprehensive check writing and payment information program. It helps you manage your expenses and plan your payment schedule.

Accounts Receivable – Blackbaud’s comprehensive billing and customer information program. It helps you manage your receivables and plan your cash flow. Along with customer account management, you can use this program for billing and payment applications, creating invoices, statements, and correspondence, as well as producing reports.

accrual – the accumulation of assets, expenses, liabilities, or revenue items whose value has been determined but for which no cash has yet been transferred.

accumulated depreciation – the cumulative amount of all depreciation (includes prior years and year-to-date depreciation).

accumulated depreciation account – the account to which accumulated depreciation is expensed. It is a contra asset account.

accumulated depreciation journal reference – the transaction identification numbers defined on the General Ledger tab in Configuration. These transaction numbers serve as an identifier for all accumulated depreciation when posting to a general ledger.

ACH – Automated Clearing House. A regional entity that electronically processes fund transfers between banks.

ACH Credit – an electronic funds transfer (EFT) initiated by an employer to a designated financial institution for the amount of a tax payment.

ACH Debit – an electronic funds transfer (EFT) in which a designated bank, with employer authorization, notifies the employer’s bank to transfer funds.

ACRS (Accelerate Cost Recovery System) – a method of depreciation used for assets that were placed in service after 1980, but before 1987.

Add – a Global Change function that adds a value to a field. This value can either replace the current value or make no changes to the current data, depending on whether you mark Overwrite existing value.

adjustment – a debit or credit added to your bank account to bring the account in balance.
**adjustment type** – a category of adjustments, such as ATM fees, minimum balance fees, or monthly service charges, associated with general ledger debit and credit accounts. When you create an adjustment, you first select an adjustment type, enter an amount, and then the program automatically fills in the corresponding general ledger information to create your adjustment.

**Adobe Acrobat Reader** – a free download from Adobe that allows electronic distribution of formatted documents.

**AFN** – Accounting for Nonprofits.

**Alternate ACRS** – method of depreciation that uses a modified Straight Line depreciation calculation. This method should only be used for assets that were placed in service after 1980, but before 1987.

**Alternate Depreciation System (ADS)** – ADS uses a Straight Line depreciation method. The ADS *must* be used for the following: tangible property used outside the United States, tax-exempt property, tax-exempt bond-financed property, imported property covered by executive order, or farming property under some circumstances.

**annotate** – notes you type to add detail about a specific account. This feature is found on the Edit menu in Bank Accounts.

**annual wage** – the fixed salary paid to an employee over the course of a calendar year.

**appendix** – supplemental information found after the last chapter in a Blackbaud user’s guide that provides detail about optional features.

**<Ask>** – a criteria operator that allows you to choose the field value query criteria at the time you run the query. When you run the query, an “Ask at Runtime” wizard appears, prompting you to select criteria for any fields defined by the <Ask> criteria operator.

**asset** – property (tangible or intangible) that has value.

**Assets** – a Blackbaud module in *Fixed Assets* where you to create an asset using the Asset Wizard, depreciate assets using a variety of schedules, track and calculate depreciation, and post and adjust transactions.

**Asset Wizard** – a utility in *Fixed Assets* that collects specific information from the user and creates an asset record.

**attributes** – a reporting tool that lets you group information based on a common theme. With attributes defined, you can filter information to your specification.

**backup withholding** – taxes withheld from an individual’s income when the proper Taxpayer Identification Number (TIN) can not be identified or when required by the Internal Revenue Service. The rate is typically 31 percent.

**balance forward** – a system configuration that automatically applies payments and credits to the total balance with the oldest charges paid first.

**Bank Account Reconciliation** – a Blackbaud optional module designed to provide in-depth details about bank activity while balancing bank accounts. *Bank Account Reconciliation* can be added to these Windows programs: *Accounts Payable, Accounts Receivable, Miscellaneous Cash Receipts, Payroll* and *Student Billing*; and it works with *General Ledger for Windows* and *The Raiser’s Edge for Windows*.

**Bank Accounts** – a shared module contained within Blackbaud accounting programs. From the Bank Accounts main screen, you initiate procedures for *Bank Account Reconciliation* (if installed) and *Check Writer*. Bank Accounts now contains the functionality for both.

**bank list** – a list of all bank accounts added in your Blackbaud software. From this list, you can filter the account information you want to display, open the bank account register, edit the bank account information, add a new bank account, or delete a bank account.

**bank summary report** – an overview statement of your account based on filters you select in the *Reports* module of your main Blackbaud accounting program. This report is useful when providing bank information to auditors or board members.

**Begins With** – a *Query and Export* criteria operator, which selects records with an entry that begins with the value you define. For example, if you choose Vendor Name Begins With Bel, vendors whose Vendor Name has “Bel” at the beginning (Bell, Bellingham, Bellmont, etc.) are selected. You can use wildcard characters with this operator.

**Between** – a *Query and Export* criteria operator, which lets you select a range of entries that records could have in order to be selected. For example, if you select Amount is Between $50 and $100, the program selects records of invoices that fall within this amount range.

**bitmap** – a file format for online art.

**biweekly payroll** – paid 26 times a year.
Blackbaud Systems – a catch-all phrase for main Blackbaud programs such as General Ledger, Student Billing, Payroll, etc.

Blank – a Query and Export criteria operator, which selects any record with a blank field you define. For example, if you choose the criteria Alias is Blank, the program selects all records with an empty Alias field.

Budget Management – a Blackbaud optional module used to enhance and expand your budget development capabilities within General Ledger.

button – a picture or word icon appearing on screens and toolbars. When clicked, buttons let you perform functions, such as saving, without using the menu bar.

C

Cash Receipts – a Blackbaud module in which you create deposits and add payment and deposit receipts. You can also print deposit tickets and receipts.

cash receipts journal – a set of parameters you define in Accounts Receivables to standardize receipt appearance.

change parameters – criteria you establish to change your database globally.

chart of accounts – a list of revenue and expense sources appearing in ascending account number order by category. This chart is maintained in General Ledger, Accounts module.

Check Writer – formerly a Blackbaud shared module. Its functionality now resides within the Bank Accounts module of Accounts Payable and Payroll.


CODA – Cash or Deferred Arrangement. This is a type of employee benefit plan, also known as 401K.

computer-based training – a self-paced, interactive form of multimedia training completed on a computer. Also known as CBTs, they can be delivered on a CD-ROM or over a network to a student workstation anywhere and at any time. Blackbaud CBTs are called Interactive Workshops.

Configuration – a shared module within Blackbaud accounting programs. This is where you define program settings and create tables that increase efficiency, accuracy, and speed data entry.

consolidation code – a General Ledger code comprised of letters or numbers that can be program-generated or user-generated. Consolidation codes filter accounts and create combinations of multiple regular accounts within multiple funds as defined in the Chart of Accounts. They are established in Configuration on the Consolidations tab.

Consumer Credit Protection Act – a federal law that limits the amount of an employee’s wages that may be subject to garnishment.

Contains – a Query and Export operator, which selects records that have your defined entry anywhere in the field. For example, if you define criteria for Vendor Name Contains Z, records with the letter “Z” anywhere in the vendor name field are selected. You can use wildcard characters with this operator.

Copy – a Global Change function that places the entire value from the source field into a compatible target field.

credit – an increase in a revenue, net worth, or liability account.

credit hold – a designation you assign to a customer record when you do not want orders from the customer to be processed without full payment.

credit limit – a monetary cap you assign to a credit record allowing customers to place orders without payment up to a certain limit.

credit memo – an entry that lets you reimburse charges previously applied.

Customers – a Blackbaud module in Accounts Receivable where you establish individual records for your customers. Each customer record maintains name, address, phone and contact information, as well as miscellaneous items such as tax, credit, statement, and discount information.

D

database validation – a procedure that scans and verifies the accuracy of your database. The program generates an error message if a discrepancy exists.

debit – an expense or deduction from a revenue, net worth, or liability account.

debit memo - an entry that lets you increase a customer’s balance, such as finance charges, membership dues, and non-sufficient fund checks.
**deduction** – an amount subtracted from an employee’s gross wages for a designated purpose, such as health insurance.

**Delete** – a *Global Change* function that allows you to delete all of the values in a specific field.

**directory** – the location on a drive where you store the names and locations of files.

**documentation** – written explanations about program functions accompanying Blackbaud software. This can include a user’s guide, an online user’s guide, and online Help.

**Does Not Begin With** – a *Query and Export* criteria operator, which selects records that do not begin with your defined entry. For example, if you choose Vendor Name Does Not Begin With Bel, vendors whose Vendor Name does not have “Bel” at the beginning are selected. You can use wildcard characters with this operator.

**Does Not Contain** – a *Query and Export* criteria operator, which selects records without your defined entry anywhere in the field. For example, if you define criteria for Vendor Name Does Not Contain Z, only records without a “Z” anywhere in the vendor name field are selected. You can use wildcard characters with this operator.

**Does Not Equal** – a *Query and Export* criteria operator, which selects only the records with entries that do not match the defined criteria. For example, if you choose City Does Not Equal Charleston, the program selects every record that does not have “Charleston” entered as the city.

**dunning letters** – automatically generated requests for past due payment. You set up these letters in the *Mail* module of Blackbaud programs.

**dynamic query** – a query type that automatically refreshes and updates results each time the query is used, providing the most current results.

---

**E**

**EFT** – Electronic Funds Transfer.

**EFTPS** – Electronic Federal Tax Payment System.

**EIC** – Earned Income Credit.

**EIN** – Employer Identification Number. The nine-digit account number assigned by the IRS for employment tax purposes.

**electronic funds transfer (EFT)** – a general banking system in which transactions, such as deposits and bill payments, are made through computer databases and electronic files. Money does not physically change hands; it transfers electronically from the payer’s account into the payee’s account. This is often referred to as EFT or direct deposit. Blackbaud’s *Electronic Funds Transfer* module adds fields and options to modules in *Accounts Payable* and *Payroll*.

**electronic reconciliation** – a process that lets you compare your bank’s Quicken Interchange Format (.QIF) with your Blackbaud file and then reconcile your account based on matches between the two.

**employee** – under the common-law rule, an individual who performs services subject to the will and control of an employer.

**Employees** – a Blackbaud module found in *Payroll* where you enter biographical, wage, and tax information for employees as well as track attendance. In addition, this program lets you store information concerning an employee’s off-site activities, such as attending seminars and conferences.

**employer** – a person or organization for whom a worker performs a service as an employee.

**Employer’s Quarterly Federal Tax Return** – the name of the Form 941 filed quarterly, reconciling the federal income tax and the FICA taxes withheld and paid.

**Equals** – a *Query and Export* criteria operator. When you choose Equals as your operator, records selected for the query must have the exact entry you define.

**Excel** – a spreadsheet program by Microsoft.

**exception query** – a query that contains all files that could not be incorporated into the function (report, etc.) because they did not meet all criteria.

**exempt employee** – an executive, administrative, professional, or outside sales person who is exempt from or not subject to the overtime and minimum wage provisions of the Fair Labor Standards Act, as amended.

**expense** – any cost incurred in the production, selling, and distribution of goods and services; expenses are deducted from revenues on the income statement to arrive at a net income.

**export** – to send to another program, such as Microsoft Excel.

**Export (module)** – see *Query and Export* module.
**Family and Medical Leave Act of 1993 (FMLA)** – a federal law requiring employers with 50 or more employees to grant up to 12 weeks of unpaid leave to employees for the birth or adoption of a child; the care of a seriously ill child, spouse, or parent; or for their own serious illness.

**FAS 117** – This stands for Financial Accounting Standard No. 117. It is a standard for nonprofit fund accounting financial statements as published by the Financial Accounting Standards Board.

**fee schedules** – a tool to automate the billing process for standard fees such as tuition, room and board, and other standard tuition related fees.


**filters** – a search and display feature that lets you control the amount of information appearing on grid screens. For example, *Bank Account Reconciliation* filters let you display bank account information based on Blackbaud program, transaction type, and transaction status.

**FITW** – Federal Income Tax Withheld.

**fixed asset** – permanent, long-life assets of a business: (i.e., land, buildings, equipment, and vehicles).

**Fixed Assets** – Blackbaud’s asset management program. This program provides everything an organization needs to manage its assets, including the ability to enter or import asset information, generate depreciation transactions automatically following IRS rules, and account for and record the disposal of assets.

**flat rate method** – a formula used to calculate the federal tax due, using the rate of 28 percent.

**Form 4562 Depreciation Summary Report** – provides summary depreciation information to help prepare IRS Form 4562-Depreciation and Amortization.

**fund** – a self-balancing set of accounts that represents a separate legal entity. Examples of funds include unrestricted, restricted, plant, and endowment. Funds must be added to *General Ledger* before you can enter accounts.

**fund code** – the first segment of an account number when *General Ledger* is configured for fund accounting.

**FUTA** – Federal Unemployment Tax Act.

**garnish** – to attach, such as money due, from a debtor while it is in the hands of a third party.

**garnishee** – a person or business served with a garnishment.

**garnishment** – a court order served on a person or firm as the result of a lawsuit to require that employer to withhold money from an employee’s pay and disperse according to the court’s direction.

**general journal batch** – a compiled group of debit and credit transactions that you can post to your ledger accounts.

**general ledger** – the primary ledger, when used with subsidiary ledgers containing all balance sheet and income statement accounts. The general ledger is used as a central reference or index for transaction posting.

**General Ledger** – a Blackbaud program designed to enhance the efficiency of your general ledger and improve the organization of your business office.

**GL interface files** – files that enable *General Ledger* to interact with Blackbaud DOS systems and *The Raiser’s Edge*. By creating interface files, you assign the *General Ledger* accounts an alternate account number that other programs can recognize.

**Global Change** – a shared module within Blackbaud programs that allows you to change multiple fields at once using various change parameters.

**global change functions** – add, replace, partial replace, move, swap, delete, increase/decrease, copy.

**Greater Than** – a *Query and Export* operator. If you select Greater Than as your operator, you indicate that records selected must have a value greater than the one you define.

**Greater Than or Equal To** – *Query and Export* operator. Selecting Greater Than or Equal To as your operator limits the records selected to those that have a value greater than or equal to the one you define.

**gross earnings** – grand total of all regular, overtime, and other compensation paid to an employee before any deductions for taxes, etc.

**group** – multiple users with the same access rights to a Blackbaud program as defined by the Supervisor in the program’s *Security* module.
**group consolidation management** – a procedure in *General Ledger* that makes the association between ledger accounts and one or more consolidations easy.

**H**

**header accounts** – one of three types of entries displayed in the *General Ledger* Chart of Accounts. Header accounts are designated by an “H” at the end of the account number. They are used for description purposes only. Activity cannot be posted to a header account. For example, there could be a header account called “Investments” followed by a listing of regular accounts, which contain investments.

**Help files** – a type of online help that lets you access information from your computer about the program in which you are working.

**hyperlink** – text or graphic in a Help file or web page that, when clicked, moves the user to a specific location. For example, the notepad graphic is a hyperlink found with procedures in the *Bank Account Reconciliation* Help files. When you click the notepad, it moves you to a blank page where you can type notes about the procedure.

**I**

**icon** – a picture that represents a particular object, command file, or group of files.

**import** – a type of file conversion that lets you load a file from a format other than the application program’s original format. For example, you can import batches from *The Raiser’s Edge* into *Bank Account Reconciliation*.

**Import** – a shared Blackbaud module that lets you import various file types into *Fixed Assets, Accounts Payable, Accounts Receivable, Miscellaneous Cash Receipts, Payroll,* and *Student Billing*.

**inactive (entries)** – entries that have been defined, but cannot be used in tables. You make entries active or inactive from the Tables tab in *Configuration*.

**Increase/Decrease** – *Global Change* function that can be used for fields containing a numeric value. You can increase/decrease values by an exact amount or by a percentage.

**installation guide** – a written explanation accompanying your software that helps you load your new software.

**Interest Income Allocation** – a Blackbaud optional module used with *General Ledger* and *Project, Grant, and Endowment Management* to define “pools” of projects for investment purposes.

**interfund** – a balancing entry between funds. This procedure automates the creation of *General Ledger* transactions to transfer money between funds. This is accomplished through *Interest Income Allocation* with *Project, Grant and Endowment Management*. Both are Blackbaud optional modules.

**involuntary deduction** – pay withheld from an employee’s paycheck at the request of someone other than the employee. For example, child support.

**IRS** – Internal Revenue Service.

**Is Not Blank** – a *Query and Export* criteria operator, which selects any record with anything in your defined entry. For example, if you select the criteria Alias Is Not Blank, the program selects records with an entry in the Alias field.

**J**

**Journal Entry** – a Blackbaud module in *General Ledger* where you create batches of transactions for posting to your *General Ledger* accounts. Through *Journal Entry*, you can create, import, validate, delete, reverse, display, print, and post batches.

**journal reference** – transaction identification numbers used during the posting process.

**L**

**legend** – an explanatory list of colors found on screens. For example, the *Bank Account Reconciliation* legend lets you select the color of specific bank account references.

**Less Than** – a *Query and Export* criteria operator. When you select Less Than as your operator, you limit the records selected to ones that have an entry less than the value you are defining.

**Less Than or Equal To** – a *Query and Export* criteria operator. When Less Than or Equal To is selected as the operator, the records selected must have an entry either equal to or less than the value you define.

**leveling** – a process in *General Ledger* that lets you determine how an account should total within a given category (e.g. asset, liability, fund balance, revenue, expense, gift, or transfer).
Like – a *Query and Export* criteria operator. The Like operator allows you to use wildcards (special characters) to replace a character or set of characters in a field.

**M**

MACRS – a depreciation method used for assets placed in service after 1986. MACRS consists of two systems GDS (the main one) and ACRS.

MACRS ADS – a Straight Line depreciation method used for the following: tangible property used outside the United States, tax-exempt property, tax-exempt bond-financed property, imported property covered by executive order, or farming property under some circumstances. This depreciation method can only be used for assets placed in service after 1986.

Mail – a shared module within Blackbaud programs where you can specify mailing parameters for labels, forms, envelopes, letters and cards.

**mandatory deductions** – deductions required or mandated by law, such as federal income tax.

media – any stored information related to an asset record (i.e., an article, warranty information, demonstration video, etc.)

menu bar – a horizontal strip of selections found under the title bar at the top of a window.

merge – to combine or join two queries to make a third query.

**merge operators** – AND, OR, XOR, and SUB. These operators allow you to determine how queries merge.

Microsoft Windows – an operating system required to run Blackbaud programs.

minimum wage – lowest legal amount an employer may pay an employee per hour.

Miscellaneous Cash Receipts – a Blackbaud program designed to complement *General Ledger for Windows* by handling the small details that can clutter a ledger. It helps you identify where small cash amounts originate, produce a detailed profile of each transaction, and print a deposit ticket.

module – a component of a program. A module is created separately and then combined with other modules to form a program. For example, the Security module is a shared component of all Blackbaud programs.

**Move** – a *Global Change* function that places the entire value from the source field into the target field and deletes the value from the source field.

**N**

NACHA – National Automated Clearing House Association. This is the national umbrella organization for regional automated clearinghouses.

net pay – the total earnings of the employee minus all the deductions. This is also known as take-home pay.

**Not Between** – a *Query and Export* criteria operator. Choosing Not Between as the operator allows you to select a range of entries that records must not have to be included in the query. For example, if you select Amount is Between $50 and $100, records of invoices that fall within this amount range are selected.

**Not Blank** – a *Query and Export* operator. The Not Blank operator selects any record with anything in the entry you define.

**Not Like** – a *Query and Export* operator. The Not Like operator selects records that do not have the entry you define. You can use wildcard characters with this operator.

**Not One Of** – a *Query and Export* operator. Choosing Not One Of as the operator means records selected must not have one of the entries you define.

**O**

OFLT – Worker’s Compensation Old Fund Liability Tax.

**on the fly** – adding an entry to a table when it does not appear on the Tables tab in *Configuration*. There are several places in Blackbaud programs where you can add information directly into a field instead of selecting a pre-defined value from the drop-down list. When you do this, the program asks you if you want to create a table entry. Click *Yes* to add the entry to the table.

**One of** – a *Query and Export* criteria operator. Choosing One of as the operator means records selected must have one of the entries you define.

online help – information accessed from a computer about the program in which you are working.

**online manual (user’s guide)** – the manual in a PDF format, which you can open and read via Adobe Acrobat Reader. It is accessible from your CD-ROM or by selecting Help, Online Documentation.
**open item** – a system configuration that lets you select a specific charge item when applying a payment. Payments can be applied automatically based on user-defined criteria.

**Optional (O)** – used in the reference section to signify that the information referenced in the field is optional. It does not have to be entered in the program.

**OR** – a *Query and Export* operator that joins two queries to make one. All records in both queries are included; however, records that appear in both queries are not duplicated.

**Or (button)** – a *Query and Export* criteria operator. Clicking Or tells the program that any output information can meet either criteria to be used.

**output query** – a query that lists the results of a function.

**overtime** – hours worked in excess of the prescribed maximum weekly (or in some states, daily) requirements.

**P**

**parameter file** – an established set of criteria, which you can save and use over and over to perform a specific function.

**Parenthesis ( )** – a combining operator used in *Query and Export* to separate a portion of the criteria formula.

**Partial replace** – a *Global Change* function that searches for records containing at least part of the value. You cannot leave the Replace field blank for partial replaces, but you can use standard wildcards (such as ? and *). This function is not available for code table fields.

**password** – a secret sequence of typed characters required to use a computer program. This prevents unauthorized users from entering a program.

**payer-based processing** – a processing method that focuses billing activity on the individuals and organizations responsible for paying a student’s charges.

**Payroll** – a Blackbaud program that simplifies your payroll and human resource management, saving you time and making in-house payroll processing a cost effective alternative to outsourcing.

**payroll period** – periods of service for which an employer usually pays wages.

**payroll register** – term used to describe a multicolon column form used in assembling and summarizing the data needed at the end of each payroll period. It lists all employees who earned remuneration, the amount of remuneration, the deductions, and the net amount paid.

**Percentage Method of Withholding** – a procedure for calculating the amount of tax withheld, using mathematical formulas and usually intended for use by employers with computerized payroll systems. May also be computed using the charts and tables in the Circular E.

**per diem** – daily allowance, usually for travel, entertainment, or miscellaneous out-of-pocket expenses while conducting a business transaction.

**Portable Document File (PDF)** – a document that maintains its formatting and displays correctly on any output device. For example, the Blackbaud user’s guides are saved in a PDF format and displayed in the Help files. This format also allows users to click on hyperlinks and jump from topic to topic.

**post** – the process of entering a transaction into Blackbaud’s *General Ledger* and updating your account balances.

**Post** – a Blackbaud module in *General Ledger* where you can post both general journal batches and batches from other Blackbaud programs to *General Ledger*.

**preferences** – computer program settings that offer individual customization. For example, Preferences in *Bank Accounts* let you select grid colors and lines.

**prenote authorization file** – an electronic test record sent to a bank to ensure correct transmission of coding, amounts, account numbers, etc. Banks often require a prenote authorization file before accepting electronic funds transfers (EFTs).

**Pre-purge Report** – creates a report for your records before any data is actually purged.

**preview** – an advance look at a document before printing.

**procedure** – a series of steps that explains how to perform a task within a computer program.

**program** – a software system. Blackbaud’s programs are composed of modules.

**Project, Grant, and Endowment Management** – an optional module in Blackbaud’s *General Ledger* designed to track details of subsidiary funds. When used with *Bank Accounts*, a Projects grid appears at the bottom of the New Adjustment screen.
Purchase Orders – an optional module in Blackbaud’s Accounts Payable program that allows you to process purchase orders and receipts for your organization.

**purge** – to erase information from your database. We recommend always making a backup copy of your database before purging. Purged files cannot be recovered.

**Purge Asset Control Report** – a report listing the assets that were purged.

**Q**

.QIF – an abbreviation for Quicken Interchange Format. This popular format is used by banks to electronically store bank account statements.

**query** – to question the database for specific information. Or, a set of defined criteria used to select and export records. When you create a query, you create a definition for the records you want to include. When you run a procedure using the query, your Blackbaud program processes only those records matching the query definition. You can also extract information from the records in the query by defining the output fields of the query. For example, you can create a query of deposits for electronic funds transfer (EFT) payments only.

**Query and Export** – a shared module within Blackbaud programs where you can create, open, run, and delete queries. Other options include refreshing, merging, and exporting queries.

**query criteria operators** – data field requirements used to narrow and focus a search within filtered information. When you define a query, you establish a set of values, or requirements, that a record must meet to be included. Query criteria operators include: Equals, Does Not Equal, Blank, Not Blank, and <Ask>.

**R**

**The Raiser’s Edge** – Blackbaud’s fund-raising software designed to enhance your fund-raising efforts and improve the organization of your development office. You can import and view batches from The Raiser’s Edge into Bank Account Reconciliation.

**reconciliation** – a function in Bank Account Reconciliation by which your account becomes balanced once you enter preliminary data.

**reversing invoices** – a procedure to convert any invoice transaction to a credit memo or sales return.

**row** – a single horizontal section in a table or grid.

**salary** – a fixed compensation paid to an employee for regular work or services.

**sales tax codes** – a way to designate the federal tax, state tax, and local option sales tax to use as part of a customer record or invoice transaction. You can specify the tax rate and whether or not it is compounded.

**salvage value** – the estimated value of the property at the end of its useful life. This must be less than the depreciation basis.

**SDI** – State Disability Insurance.

**Security** – a shared module within Blackbaud programs where you establish access rights for groups of users.
**security groups** – a collection of users with the same access privileges within a Blackbaud program.

**security users** – Individuals given access privileges within a Blackbaud program based on security group membership.

**semimonthly payroll** – paid 24 times per year.

**separator character** – the symbol that appears between your General Ledger account number segments. From Utilities and Housekeeping, select Change Separator Character, and choose from dash, comma, slash, backslash, semicolon, or period.

**shared module** – a component of a program that is created separately and then combined with other modules to form a program. For example, the Security module is a shared component of all Blackbaud programs.

**shift differential** – rate adjustment paid to employees working certain shifts.

**shortcut keys** – tools to speed data entry. Function keys are the primary source for shortcuts. When a function key is available, the status bar at the bottom of the open window tells you which key to press.

**shortcut menu** – a menu displayed when you place your cursor in a field or grid, and then click the right mouse button. A shortcut menu lets you access commonly used commands.

**Sounds Like** – a Query and Export criteria operator. The Sounds Like operator can be used when you want to select records based on a field for which you do not know the exact spelling.

**source codes** – a code used to define the origin of a transaction. Some examples are accounts payable, accounts receivable, cash receipts, general journal, adjustments, fixed assets, purchase orders, and gifts. Source codes are added on the Tables tab in Configuration.

**statement codes** – a code used to define the frequency with which customers receive invoices, such as weekly, monthly, quarterly and annually. By defining these codes you create a statement cycle.

**static query** – a type of query that provides a record of the information you select at the time you establish the query. If you run a report two months later using the same query, the system uses the list of records stored in the original query.

**status bar** – displays important messages across the bottom of the screen to assist you in the program. For example, when the cursor is in a field with a Table Lookup available, the message “Press F7 for Table Lookup” displays in the status bar.

**Straight Line Depreciation** – depreciation method that expenses an asset value in equal amounts over its useful life.

**Students** – a module in Blackbaud’s Student Billing program where you create and maintain records containing information about students, parents/guardians, and organizations. This is where you set up billing schedules and payment distributions. You also enter charges, credits, and refunds.

**student-based processing** – a processing method that focuses billing activity on the student record. While anyone can make payments, all transaction activity is recorded on the student record.

**Student Billing** – a Blackbaud program designed to simplify the production of billing statements, while offering the capacity for storing detailed information about students, parent/guardians, and organizations.

**SUB** – the order of the queries is important when using SUB to merge queries, because the merged query contains only those records that are exclusively in the first (primary) query. All records that appear only in the second (secondary) query and records that appear in both queries are eliminated.

**SUI** – State Unemployment Insurance.

**Sum of Years Digits** – accelerated depreciation method. Under this method, depreciation is determined by multiplying the asset’s cost less salvage value by a fraction in which the sum of the year’s digits is the denominator and the number of years remaining in the asset’s life is the numerator.

**supervisor** – a user with the password who can enter the computer program. The supervisor establishes access rights for all users through Security, a shared module.

**supplemental wages** – items paid in addition to regular wages. Examples of supplemental wages include: awards, bonuses, retroactive wage increases, and tips.

**SUTA** – State Unemployment Tax.

**Swap** – Global Change function that allows you to place the entire value from the source field to the target field and the original value of the target field in the source field.
**system** – the internal computer operating component that runs the programs a user installs. In this manual “program” is used instead of “system.”

**Systems Basics** – the name of a chapter in most manuals where you learn about the screens and functions available in the program or optional module.

**T**

**table lookup** – a feature that lets you select and enter information into fields by pressing F7. This can save typing time.

**tabs** – an organizational device that holds specific information within pages on a screen. For example, the Add a Group screen in *Security* includes multiple tabs.

**term discounts** – a way to define whether customers can receive price reductions based on early payment.

**title bar** – a horizontal strip identifying a program or file and located at the top of a screen. For example, the title bar on *Security* displays a lock and key icon and the module name.

**toolbar** – a horizontal strip with buttons that, when clicked, perform specific tasks. It is located under the title bar at the top of a screen. For example, the *Bank Account Reconciliation* toolbar has buttons for *New, Bank Account List, Reconcile, Reconciliation Setup, Bank Summary,* and more.

**total accounts** – one of three types of entries displayed in the *General Ledger* Chart of Accounts. Total accounts are designated by a “T” at the end of the account number. These accounts provide sub-totals on financial statements for the balances of regular accounts.

**U**

**UHIC** – Unemployment Health Insurance Contribution.

**useful life** – the period of time that a business asset is determined to have commercial value for depreciation purposes; the IRS determines useful life depreciation periods.

**user preferences** – preferences you can create in *Configuration* that are unique to your user id.

**user's guide** – a published manual that explains how to use a Blackbaud program.

**Users in System Form** – used in *Utilities and Housekeeping* to show how many users are logged into a Blackbaud program. There are several processes in *Utilities and Housekeeping* that require all users to exit the system before you can perform the process.

**utilities** – a command found on the *Bank Accounts* main screen where you can initiate Post to General Ledger, Purge Voided Checks, Reconciliation History, and Raiser’s Edge Import.

**Utilities and Housekeeping** – a shared module within Blackbaud programs where you perform general database tasks such as viewing system statistics.

**V**

**Validate Database** – a procedure used in *Utilities and Housekeeping* that analyzes your database to determine data corruption or any inconsistencies.

**Vendors** – a module in Blackbaud’s *Accounts Payable* where you establish individual records for your vendors.

**vertical truncation report** – a report that details where information on labels will be cut off vertically.

**voluntary deductions** – amounts withheld from an employee’s pay at the request of the employee, such as health insurance premiums or union dues.

**W**

**W-2 form** – Income and Tax Statement. A six-part combined federal/state form given to employees and furnished to the Social Security Administration by January 31 of each year. It shows total wages and other compensation paid, as well as taxes withheld and other requested amounts.

**W-3 form** – Transmittal of Income and Tax Statements. Used to summarize and transmit the paper W-2 forms submitted to the SSA.

**W-4 form** – Withholding certificate used to determine the correct withholding tax on the federal level. Completed by the employee and used by the employer.

**wildcard criteria operator** – a special character or a series of characters (such as ?, *, and %) used to define the conditions a record must meet to be selected.
**wizard** – a utility that collects specific information from the user and creates a unique file. This unique file may be used as a template. For example, *Bank Account Reconciliation* requires users to run a Setup Wizard for each bank account. This creates a template of the account for use in all future reconciliations.

**worker's compensation** – benefits paid to employees who suffer work-related injuries or illness.

**workweek** – a fixed and regularly recurring period of 168 consecutive hours, such as seven consecutive 24-hour periods.

**X**

**XOR** – determines the final query, which contains all records that appear in either query, but excludes any records that appear in both queries.

**Y**

**year-to-date depreciation** – the depreciation that has occurred from the beginning of the year until the current date.

**Year-to-Date Depreciation Report** – lists depreciable basis, prior year’s depreciation, and year-to-date depreciation expense for selected assets.
Index

A
account balance 7
Accounts Payable 28, 31
Accounts Receivable 28
adjustment types
  adding, editing, deleting 45–46
  tab 45
adjustments
  adding 47–48
  adding, deleting during reconciliation 30
  new adjustment screen 47
Adobe Acrobat Reader 3

B
Bank Account Reconciliation
  combined transactions screen 31
  detail 37
  expanding grid 40
  history 37
  icon 28
  overview 28
  preferences 38–39
  report 33
  separated transactions screen 32
  works with 2
Bank Accounts
  main screen 6
  menu enhancements 10–11
bank register grid
  picture of 7
  sorting information 12
bank statement 29
bank summary report 85
batches 54
Blackbaud systems tab 78
buttons
  standard 9
  toolbar 8

C
calculator 13
calendar 13
checks tab 21
clock symbol 3
columns 40, 42
criteria option 80

D
dates. See calendar
deposits tab 22
design elements 3
documentation 2

E
Excel, exporting to 16

F
figures. See calculator
file menu 10
filters
  Bank Account Reconciliation screen 31
  description 8
  picture of 7
  find feature 22
  font options 64
  format tab 78–84
  criteria option 80
  headings option 79
  miscellaneous option 81
  page footer 80
  post to GL screen 53
  report footer 81

G
General Ledger
  Journal Entry transactions 28
  posting to 50–53
  using with Bank Account Reconciliation 15
general tab
  new report screen 82
  post to GL screen 51
  setup wizard screen 20
grid
  picture of 7
  sorting information 12

H
headings option 79
help file 4
help menu 11
history 37

I
importing batches 54–56
incomplete reconciliation 34

J
Journal Entry 28

L
left mouse button 11
legend 41

M
main screen
   Bank Accounts 6
   Reports 63
menu bar
   description 7
   picture of 7
menus
   file 10
   help 11
   shortcut 11
   utilities 10
   view 10
Miscellaneous Cash Receipts 28
miscellaneous option 81
mouse
   left button 11
   right button 11

N
new adjustment
   screen 47
new report screen
   Blackbaud systems tab 78
   format tab 78–84
   general tab 82
   transaction type tab 84
note symbol 3
notes
   help file 3
   margin symbols 3

O
online help 4
optional module 2
out-of-balance reconciliation 33
overview 2

P
page footer 80
password 14, 39
Portable Document Format 2
posting
   completing the Format tab 53
   completing the General tab 51
   completing the Posting Details tab 52
   printing, previewing a pre-posting report 53
rules 50
preferences
   changing in reconciliation 38–39
   setting in reports 64
pre-reconciliation report 32
Project, Grant, and Endowment Management
   using with Bank Account Reconciliation 16

R
Raiser’s Edge
   importing batches 54–56
reconcile bank account screen 28–30
reconciliation complete screen 33
reconciliation detail 37
reconciliation history 37
reconciliation icon 28
reconciliation report 33
register report 88
report footer 81
reports
   Blackbaud systems tab 78
   creating, previewing, printing 65
   exporting, e-mailing 75
   font options 64
   format tab 78–84
   general tab 65, 82
   generating 64–76
   sample reports 84–89
   setting preferences 64
   transaction type tab 84
right mouse button 11

S
Security
   module 14–15
setup wizard
   checks tab 21
   deposits tab 22
   find feature 22
   general tab 20
   summary tab 23
setup, overview 2
shared module
Reports 62
Security 14
sorting, grid information 12
spreadsheet, Excel 16
status bar
description of 8
picture of 7
stoplight symbol 3
Student Billing 28
summary display, removing 40
summary tab 23
symbols, in margin notes 3
system analysis report 87

T
title bar 7
toolbar 8
picture of 7
removing 40
transaction report 89
transaction total 7
transaction type tab 84

U
user’s guide 2
utilities menu 10

V
view menu 10

W
wizard. See setup wizard

Z
zero amount, deleting adjustments 30